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Introducción 1

Contenido de este capítulo
• Resumen: página 1

• Asistencia técnica: página 3

• Dispositivos compatibles: página 3 

• Cómo utilizar esta guía: página 6

• Seguridad del usuario: página 6

Resumen

Gracias por elegir a Medtronic Diabetes como aliado para que usted 

y sus pacientes tengan un mejor control del tratamiento de la diabetes. 

Creemos que se beneficiará de la tecnología de vanguardia del programa 

CareLink™ Pro y de la sencilla interfaz de usuario basada en menús.

Esta guía del usuario describe cómo utilizar el programa CareLink Pro 

para adquirir, almacenar y generar informes de los datos de tratamiento 

y diagnóstico del paciente. También describe la opción para acceder 

a los datos de glucosa de la bomba, del medidor y del sensor que los 

pacientes han transferido a CareLink™ Personal, un programa para la 

gestión del tratamiento basado en web que funciona con el programa 

CareLink Pro.
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Características     

El programa CareLink Pro es un programa para la gestión del tratamiento 

de la diabetes para ordenadores personales (PC). Incluye las siguientes 

características:

• Pueden crearse registros de pacientes para almacenar datos obtenidos 

del dispositivo de un paciente así como datos de la terapia de su 

cuenta del progama CareLink Personal. 

• Los datos de las bombas de insulina, de los monitores y de los 

medidores de glucosa pueden enviarse al progama, almacenarse 

y después utilizarse para generar informes.

• Opcionalmente, se comunica con el progama CareLink Personal, 

permitiendo el acceso a los datos del dispositivo que los pacientes 

han almacenado ahí. Esto es ideal para crear informes actualizados 

entre las visitas al consultorio, y puede hacer innecesario leer los 

datos del dispositivo durante las visitas. 

• Pueden crearse diferentes informes de la terapia a partir de los datos 

del dispositivo almacenados en el registro del paciente. Los informes 

ayudan a responder a preguntas del tratamiento tales como el 

cumplimiento por parte del paciente, los patrones y las excepciones.

• El progama le avisa si hay actualizaciones del software disponibles 

para descargar e instalar. Esto le garantiza tener acceso a las 

características más recientes. 

• La función Guide Me (Guíame) es una ayuda para los usuarios 

que utilizan el progama CareLink Pro por primera vez. Proporciona 

sugerencias y consejos sobre las tareas que están realizando.

• El programa dispone de un sistema de ayuda integrado que 

proporciona información sobre áreas específicas de interés.

Seguridad

• El progama CareLink Pro puede protegerse con contraseña.

• La transmisión de los datos de pacientes desde el progama CareLink 

Personal se encripta mediante SSL (Secure Sockets Layer, capa de 

protección segura), un estándar de la industria.



Guía del usuario del programa CareLink Pro™    Introducción      3

Documentos relacionados     

Todos los documentos de Medtronic MiniMed indicados a continuación 

contienen información específica del dispositivo que no se trata en 

detalle en esta guía del usuario. 

NOTA: Para los
medidores de otras

compañías, véanse las
instrucciones incluidas

por el fabricante con el
medidor.

• Guía del usuario de la bomba de insulina Paradigm

• Guía del usuario del monitor Guardian REAL-Time

• Guía del usuario de las características del sensor

• Guía del usuario de ComLink

• Guía del usuario del dispositivo USB CareLink

Asistencia técnica

Si necesitase ayuda adicional con este sistema, póngase en contacto 

con el representante local más cercano. Si desea obtener información 

sobre la lista de contactos internacionales, acuda a la siguiente página:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Es posible que
algunos de los

dispositivos
compatibles con este

programa no estén
disponibles en todos los

países en los que el
programa está

aprobado para su uso.

Dispositivos compatibles

El progama CareLink Pro obtiene datos de los dispositivos indicados 

a continuación.           

Bombas de insulina/monitores de glucosa 

Bombas de Medtronic MiniMed 508

Bombas de insulina de la serie Paradigm 
de Medtronic MiniMed 

511, 512, 712, 515, 715, 522, 722, 
522K, 722K, Paradigm® REAL-Time 
Revel™ (523, 723, 523K, 723K),  
Paradigm® Veo™ (554, 754)  

Monitor Guardian REAL-Time CSS-7100
CSS-7100K
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Fabricante Medidores de glucosa     

Dispositivos asociados 
compatibles con Medtronic 
Diabetes:

• Bayer CONTOUR® LINK

• LifeScan OneTouch® UltraLink™

• Monitor de glucosa en sangre BD Paradigm Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Familia Bayer:

• BREEZE™

• BREEZE™ 2

• CONTOUR®

BD: • Logic®

Familia
Bayer Ascensia® DEX®,
incluyendo los siguientes 
medidores compatibles:

• Ascensia® DEX®

• Ascensia® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Familia Bayer Ascensia
ELITE™, incluyendo los 
siguientes medidores 
compatibles:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini

• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active
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Dispositivos equivalentes

Al añadir un dispositivo al progama, hay que seleccionar la marca y el 

modelo en una lista. Si no aparecen en la lista la marca y el modelo 

de un dispositivo, consulte la siguiente tabla para encontrar uno 

equivalente.

Dispositivos de comunicación                 

 Com-Station

Para uso con la bomba MiniMed 508. 
(Véanse en la guía del usuario de 
Com-Station los detalles sobre los 
requisitos de hardware).

ComLink

Para uso con la bomba MiniMed Paradigm 
y el monitor Guardian REAL-Time. 
(Véanse en la guía del usuario de ComLink 
los detalles sobre los requisitos de 
hardware). 

Monitor de glucosa en sangre 
Paradigm Link®

Para uso con la bomba MiniMed Paradigm 
y el monitor Guardian REAL-Time. 
(Consulte en la guía del usuario del 
medidor de glucosa en sangre 
Paradigm Link® los detalles sobre los 
requisitos de hardware).

USB CareLink™ Para uso con la bomba MiniMed Paradigm 
y el monitor Guardian REAL-Time.

Cable de comunicación de datos

Para uso con medidores de glucosa 
de otros fabricantes. Cada fabricante 
de medidores suministra un cable de 
comunicación de datos.

Si el paciente utiliza uno de estos 
dispositivos

Seleccione este dispositivo

• Bayer Ascensia® DEX®

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2 

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2 

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™
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NOTA: Los medidores
pueden solicitarse a las
respectivas compañías.

Pedidos                       

Para realizar un pedido de productos de Medtronic Diabetes, contacte 

con su representante local. Si quiere obtener información sobre la lista 

de contactos internacionales de Medtronic, vaya a la siguiente página:

http://www.medtronicdiabetes.com/help/contact/locations.html

Cómo utilizar esta guía

Consulte el Glosario para ver las definiciones de los términos 

y funciones. En la tabla siguiente se definen las convenciones 

empleadas en esta guía.

Esta guía del usuario muestra ejemplos de las pantallas del programa. 

Las pantallas del progama real pueden ser ligeramente diferentes.

Seguridad del usuario

Indicaciones de uso 

El progama CareLink Pro está destinado a utilizarse como herramienta 

para facilitar la gestión de la diabetes. La finalidad de este progama 

es recoger la información transmitida por bombas de insulina, medidores 

Término/estilo Significado

Hacer clic Pulsar el botón izquierdo del ratón sobre un objeto 
de la pantalla para seleccionarlo. 

Hacer doble clic Pulsar dos veces el botón izquierdo del ratón sobre 
un objeto de la pantalla para abrirlo.

Hacer clic con el botón 
derecho

Pulsar el botón derecho del ratón sobre un objeto 
de la pantalla para abrir otra ventana o menú.

Texto en negrita
Se utiliza para una opción de menú o una ruta de menú. 
Por ejemplo: Patient (Paciente) > New Patient (Nuevo 
paciente)

Texto en MAYÚSCULAS Indica un botón. Por ejemplo: SAVE (Guardar).

Texto en cursiva Se utiliza para los nombres de pantallas y de campos. 
Por ejemplo: Pantalla Reports (Informes)

NOTA: Información adicional.

PRECAUCIÓN: Avisa de un peligro que, de no evitarse, podría causar 
daños leves o moderados al programa o al equipo.

ADVERTENCIA: Le avisa de un peligro potencial que, de no evitarse, 
podría causar lesiones graves o incluso la muerte. 
Puede describir también posibles reacciones adversas 
graves y peligros de seguridad.
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de glucosa y sistemas de monitorización continua de glucosa 

y transformarla en informes del progama CareLink Pro. Los informes 

proporcionan información que puede utilizarse para identificar 

tendencias y hacer un seguimiento de las actividades cotidianas, 

como la cantidad de carbohidratos ingeridos, las horas de las 

comidas, la administración de insulina y las lecturas de glucosa. 

Advertencias 

• Este progama está destinado a ser utilizado por un equipo médico 

familiarizado con la gestión de la diabetes. 

• Los resultados del progama no están pensados para establecer un 

dictamen médico y no deben utilizarse con dicho objetivo. 

• Este producto sólo debe utilizarse con los dispositivos compatibles 

indicados en este documento. (Consulte el apartado Dispositivos

compatibles, en la página 3).

• Debe aconsejarse a los pacientes que controlen sus niveles de glucosa 

en sangre al menos 4 — 6 veces al día.

• Debe indicarse a los pacientes que no realicen cambios en su tratamiento 

sin consultar antes a su equipo médico.

• Debe indicarse a los pacientes que las decisiones terapéuticas que 

tomen deben basarse en las instrucciones del equipo médico y en los 

resultados del medidor de glucosa en sangre y no en los resultados del 

sensor de glucosa.

Contraindicaciones 

Este software no debe utilizarse con dispositivos no mencionados en 

el apartado Dispositivos compatibles, en la página 3. Tampoco debe 

utilizarse este producto para el tratamiento de enfermedades distintas 

de la diabetes.

Antes de abrir este programa, cierre los siguientes programas que 

estén ejecutándose en ese momento en el ordenador:

• Programa CGMS® System Solutions™

• Programa Solutions® Pumps & Meters software 

• Progama Guardian® Solutions®

• ParadigmPAL™

• CareLink™ Personal

• Programa Solutions® para CGMS® iPro
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Navegación por el programa 2

Contenido de este capítulo
• Resumen: página 8

• Cómo abrir CareLink Pro: página 9

• Áreas de trabajo: página 10

• Barra Menú principal: página 12

• Barra de herramientas: página 12

• Función Guide Me (Guíame): página 13

• Vínculos Learn More (Más información): página 14

• Sistema de ayuda: página 14

Resumen

Este capítulo le servirá para familiarizarse con la interfaz gráfica del 

usuario del programa CareLink™ Pro. La interfaz del usuario incluye 

menús, una barra de herramientas, una barra de navegación, áreas 

de trabajo y la ventana Guide Me (Guíame). 
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Cómo abrir CareLink Pro    

1 Haga doble clic en el icono del programa CareLink Pro en el escritorio 

del ordenador.

Si su hospital requiere que introduzca una contraseña, se muestra la 

pantalla de inicio de sesión.

a. Escriba la contraseña en el campo Password (contraseña).

NOTA: La necesidad de
introducir una

contraseña es una
función opcional que se

configura durante el
proceso de instalación.

b. Haga clic en LOGIN (Iniciar sesión).

Aparece la pantalla de inicio.

2 Para iniciar un nuevo registro de paciente, haga clic en NEW PATIENT 

(Nuevo paciente). Para abrir un registro de paciente de una lista de 

pacientes del sistema, haga clic en OPEN PATIENT (Abrir paciente).

 Icono del escritorio
del programa
CareLink Pro
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Áreas de trabajo

NOTA: Consulte los
otros capítulos de esta

guía del usuario si
desea información

detallada sobre las
áreas de trabajo y cómo

utilizarlos.

Si tiene abierto un registro de paciente, puede hacer clic en uno de 

los botones de la barra de navegación para mostrar el área de trabajo 

correspondiente. Utilice estas áreas de trabajo para introducir  o seleccionar 

información para realizar tareas del programa CareLink Pro para ese 

paciente.

• Profile (Perfil): le permite mantener almacenada información del 

paciente tal como el nombre y la fecha de nacimiento. Esta área de 

trabajo también le permite conectarse a la cuenta CareLink Personal 

de un paciente.

• Devices (Dispositivos): le permite almacenar información necesaria 

para leer los dispositivos de un paciente.

• Reports (Informes): le permite seleccionar parámetros y elegir los 

informes que desee generar para el paciente.

Hasta que se añada y se guarde un perfil para un paciente, sólo puede 

accederse al área de trabajo Profile (Perfil) para ese paciente. Hasta 

que se añadan dispositivos para un paciente, sólo puede accederse 

a las áreas de trabajo Profile (Perfil) y Devices (Dispositivos) para ese 

paciente.

menú principal

área de 
trabajo 
activa

acceder a la lista 
de pacientes

añadir un nuevo
paciente

barra de navegación

barra de estado

botón del área de
trabajo Reports

(Informes)
botón del área de

trabajo Devices
(Dispositivos)

botón del área de
trabajo Profile

(Perfil)

mostrar/ocultar la ventana 
Guide Me (Guíame)
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Áreas de trabajo

Área de trabajo Devices (Dispositivos)

Área de trabajo Profile (Perfil)

Área de trabajo Reports (informes)

Profile 
(Perfil)

Devices
(Dispositivos)

Reports
(Informes)
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Barra Menú principal

A continuación se presentan las opciones disponibles en el menú 

principal. También puede accederse a algunas de estas opciones 

de menú utilizando el método abreviado de teclado indicado junto 

a la opción de menú (por ejemplo, Ctrl+N para New Patient [Nuevo 

paciente]). También puede utilizar la barra de navegación o la barra 

de herramientas para acceder a algunas opciones de menú.

Barra de herramientas

La barra de herramientas del programa CareLink Pro proporciona un 

acceso rápido a funciones de uso frecuente. La barra de herramientas 

contiene los botones siguientes.

Botón Nombre Función

Add Patient 
(Añadir paciente)

Abre un área de trabajo Profile (Perfil) 
que le permite añadir un nuevo registro 
de paciente al programa.

Open Patient 
(Abrir paciente)

Abre la tabla Patient Lookup (Búsqueda 
de pacientes), en la que puede elegir un 
registro de paciente existente para ver.

Guide Me 
(Guíame)

Muestra u oculta la ventana Guide Me 
(Guíame). Haga clic para ver sugerencias 
contextuales del programa. 
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Fichas de paciente

Cuando se abre un registro de paciente, se muestra una ficha en la 

barra de herramientas con el nombre del paciente. Cuando una ficha 

está activa, significa que el registro del paciente y el área de trabajo 

están activos, y que puede realizar tareas del programa CareLink Pro 

para el paciente.

El registro de un paciente puede activarse simplemente haciendo clic 

en su ficha de paciente. Para cerrar su registro, haga clic en el botón 

CLOSE (Cerrar) de su ficha.

Función Guide Me (Guíame)

La función Guide Me (Guíame) está presente continuamente en el 

programa CareLink Pro. Abre una ventana con sugerencias y consejos 

contextuales para acciones que podría realizar en la parte del programa 

que está activa. Las ventanas de la función Guide Me (Guíame) 

también pueden incluir vínculos >> learn more (Más información). 

Al hacer clic en estos vínculos, se accede a la sección relevante de 

la ayuda en línea que muestra información más detallada. La función 

Guide Me (Guíame) está activada de manera predeterminada. Sin 

embargo, puede desactivarla en cualquier momento.

botón CLOSE 
(Cerrar) 

ficha inactiva ficha activa

Botón CLOSE
(Cerrar)
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Activar y desactivar la función Guide Me (Guíame) 

Opción de botón

• Haga clic en el botón GUIDE ME (Guíame) para activar o desactivar la 

función Guide Me (Guíame).

Opción de menú

• Seleccione Help > Guide Me (Ayuda > Guíame) para seleccionar 

o anular la selección de la función.

Vínculos Learn More (Más información)

Los vínculos Learn More (Más información) le llevan a un tema relacionado 

del sistema de ayuda en línea. Están presentes a lo largo de todo el 

sistema en las ventanas Guide Me (Guíame) o en el programa. Haga 

clic en >> learn more (Más información) si no está seguro de cómo 

proceder o qué valores introducir.

Sistema de ayuda

El sistema de ayuda está disponible para ayudarle a utilizar el programa 

CareLink Pro. Proporciona información acerca de cómo realizar tareas 

en el programa. 

Para acceder al sistema de ayuda, proceda de una de las siguientes 

maneras:

• Seleccione Help > Medtronic CareLink Pro Help (Ayuda > Ayuda de 

Medtronic CareLink Pro). 

• Pulse el botón F1.

Botón Guide Me
(Guíame)

vínculo learn more (Más información)
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Cómo comenzar 3

Contenido de este capítulo
• Antes de empezar: página 15

• Cómo abrir y cerrar registros de pacientes: página 17

• Configuración de las preferencias del programa: página 18 

Este capítulo le guía para iniciar el programa CareLink™ Pro, abrir 

y cerrar registros de pacientes, y establecer las preferencias que 

desee aplicar a todos los pacientes del programa. 

Antes de empezar

Si esta es la primera vez que utiliza el programa CareLink Pro, debe 

asegurarse de configurar las preferencias generales (consulte el apartado 

Preferencias generales, en la página 18). Estas preferencias determinan 

cómo se muestran ciertos elementos en el programa y en los informes, 

y cómo desea que el programa se comunique con internet.

Las preferencias pueden configurarse en cualquier momento. Si lo desea, 

puede esperar a estar familiarizado con el programa CareLink Pro para 

configurar las demás preferencias.
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Tareas principales del programa

En la tabla siguiente se resumen las tareas principales que hay que realizar 

al configurar y utilizar por primera vez el programa CareLink Pro. 

También se indica en qué parte de esta guía del usuario se comenta 

cada tarea.

Paso Ubicación

Familiarícese con la interfaz del usuario 
del programa CareLink Pro.

Capítulo 2, Navegación por el 
programa

Definir las opciones globales del 
programa que utilizará el centro 
sanitario.

Configuración de las preferencias del 
programa, en la página 18

Crear perfiles para cada paciente. Cómo añadir nuevos perfiles, 
en la página 25

Conectarse a las cuentas el programa 
CareLink Personal de sus pacientes.

Cómo conectar al programa 
CareLink Personal (opcional), 
en la página 26

Añadir la bomba y los medidores de los 
pacientes a sus perfiles.

Cómo añadir un dispositivo, 
en la página 36

Leer los datos de la bomba y de los 
medidores de los pacientes.

Cómo leer los datos de un 
dispositivo, en la página 43

Configurar y generar informes para cada 
paciente.

Cómo crear informes, en la página 47

Hacer periódicamente una copia de 
seguridad de la base de datos el 
programa CareLink Pro.

Cómo hacer una copia de seguridad de 
una base de datos, en la página 62

Actualizar el programa CareLink Pro.
Actualizaciones del programa, 
en la página 61
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Cómo abrir y cerrar registros de pacientes

Cómo abrir registros de pacientes           

Puede abrirse un máximo de seis registros de pacientes al mismo 

tiempo. Si no ha creado todavía ningún perfil de paciente, consulte 

el apartado Cómo añadir nuevos perfiles, en la página 25.

1 Seleccione File > Open Patient (Archivo > Abrir paciente) o haga clic 

en el botón OPEN PATIENT (Abrir paciente). Se muestra una lista de 

pacientes similar a la presentada a continuación.

NOTA: Si recibe un
mensaje que indica que

tiene demasiados
registros de pacientes
abiertos, haga clic en

OK (Aceptar), cierre un
registro y continúe.

2 Localice el nombre del paciente en la lista escribiendo parte de su 

nombre o su nombre completo en el campo Find a Patient (Buscar 

paciente). Cuando el nombre del paciente aparezca resaltado en la 

lista, haga clic en OPEN (Abrir), haga doble clic en el nombre en la 

lista o pulse ENTER (Intro). También puede desplazarse por la lista 

utilizando las flechas arriba y abajo del teclado. 

Se muestra el área de trabajo Devices (Dispositivos) (si no se han 

añadido todavía dispositivos) o Reports (Informes) del paciente.

3 Para ver el área de trabajo Profile (Perfil) del paciente, haga clic 

en el botón PROFILE (Perfil) en la barra de navegación.

Botón Open Patient
(Abrir paciente)

Botón Profile (Perfil)
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Cómo cerrar registros de pacientes        

1 Asegúrese de que esté activo el registro de paciente que desee 

cerrar (la ficha aparece resaltada).

2 Realice una de las acciones siguientes:

a. Seleccione File > Close Patient (Archivo > Cerrar paciente).

b. Haga clic en el botón CLOSE (Cerrar) en la ficha del paciente.

c. Pulse CTRL+F4.

Configuración de las preferencias del programa             

Estas preferencias se aplican a todos los pacientes del programa. 

Las preferencias aplicables únicamente a pacientes individuales se 

describen en el apartado Comprobación de la configuración de los 

informes, en la página 51.

Las preferencias se presentan en los siguientes grupos:

• General (Generales)

– Unidades de glucosa

– Unidades de carbohidratos

– Comunicaciones

– Resolución de problemas
• Patient Profile (Perfil del paciente)

– Permite seleccionar y organizar los campos de datos en los 
perfiles de pacientes.

• Patient Lookup (Búsqueda de pacientes)

– Permite modificar y cambiar el orden de los campos mostrados 
cuando se elige Open Patient (Abrir paciente) para ver una lista 
de pacientes.

• Report Generation (Generación de informes)

– Permite seleccionar los campos de datos que se desee mostrar 
al seleccionar los datos de los informes Daily Detail (Detalles 
diarios) en la tabla de datos.

Preferencias generales  

1 Seleccione Tools > Options (Herramientas > Opciones). Aparece la 

ventana mostrada a continuación.

Botón CLOSE (Cerrar)
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2 Haga clic para seleccionar el botón de opción del valor que desee:

– Glucose Units (Unidades de glucosa): mg/dL o mmol/L.
– Carbohydrate Units (Unidades de carbohidratos): grams (gramos) 

o Exchanges (Raciones).
a. Si ha seleccionado la opción Exchanges (Raciones) en 

Carbohydrate Units (Unidades de carbohidratos), escriba 
el número correspondiente en el campo grams are equal 
to 1 Exchange (gramos equivalen a una ración).

3 En la siguiente opción Communications (comunicaciones), haga clic 

para seleccionar la casilla de verificación (activar) o para dejar vacía 

la casilla (desactivar):

NOTA: Asegúrese de
seguir las instrucciones

de su centro o del
departamento

informático cuando
configure las

preferencias de
comunicaciones.

– Automatically check for software updates (Comprobar 
automáticamente la disponibilidad de actualizaciones del software):
si se selecciona esta opción, se enviará un aviso a cada programa 
que esté ejecutando el programa CareLink Pro siempre que haya 
disponible una actualización del programa. El usuario activo tendrá 
la oportunidad de descargar e instalar las actualizaciones. Para 
evitar que suceda esto e instaurar una distribución controlada de las 
actualizaciones del software, deje vacía esta casilla de verificación.

– Synchronize with CareLink™ Personal (Sincronizar con CareLink™

Personal): si desea que el programa sincronice automáticamente 
los datos de CareLink Personal de sus pacientes cada vez que abra 
su perfil, seleccione la casilla de verificación Synchronize with 
CareLink Personal (Sincronizar con CareLink Personal). Si deja vacía 
esta casilla de verificación, tendrá que sincronizar manualmente 
los datos del programa CareLink Personal para cada paciente.
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4 Haga clic para seleccionar la casilla de verificación o para dejarla 

vacía en la sección Troubleshooting (Resolución de problemas). 

Si la casilla de verificación está seleccionada, la aplicación guarda 

un registro de lecturas del dipositivo para resolución de problemas.

5 Haga clic en OK (Aceptar) para guardar las preferencias generales. 

Preferencias de los perfiles de pacientes

1 Seleccione Tools > Options (Herramientas > Opciones). 

2 Haga clic en la ficha Patient Profile (Perfil del paciente). Aparece 

la ventana mostrada a continuación.

Cómo elegir campos de datos  

1 Utilice las casillas de verificación para añadir los campos que desee.

NOTA: Los campos First
Name (Nombre) y Last

Name (Apellidos) no
pueden eliminarse.

2 Para eliminar un campo del perfil, deje vacía su casilla de verificación.

3 Para hacer que un campo sea obligatorio, seleccione la casilla de 

verificación correspondiente en la columna Required (Obligatorio). 

Los campos obligatorios deben rellenarse para poder crear un perfil.

Cómo añadir un campo personalizado

1 Seleccione la casilla de verificación situada a la izquierda de un 

campo personalizado vacío.

Utilice las casillas de verificación para elegir los campos que desee incluir en el 
perfil. Utilice las flechas arriba y abajo para ordenar los campos.
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2 Introduzca el nombre del campo (p. ej., Contacto para urgencias). 

Este es el nombre del campo que aparecerá en el perfil del paciente.

3 Para hacer que el campo sea obligatorio, seleccione la casilla de 

verificación correspondiente en la columna Required (Obligatorio).

NOTA: Para eliminar un
campo personalizado

del perfil, deje vacía la
casilla de verificación

situada junto al campo
en cuestión.

Cómo cambiar el orden de los campos de datos         

• Seleccione el campo que desee mover y haga clic en las flechas arriba 

o abajo para moverlo. (Las flechas situadas en la parte superior 

e inferior mueven un campo hasta el comienzo o el final de la lista). 

Finalización de las preferencias de los perfiles de pacientes

• Cuando la lista Field Order (Orden de campos) tenga todos los campos 

que desea en el orden correcto, haga clic en OK (Aceptar).

Los perfiles de pacientes ya tienen los campos que acaba de seleccionar, 

en el orden seleccionado.

Preferencias de búsqueda de pacientes

1 Seleccione Tools > Options (Herramientas > Opciones). 

2 Haga clic en la ficha Patient Lookup (Búsqueda de pacientes). 

Aparece la ventana mostrada a continuación.

Flechas arriba y abajo

Utilice las casillas de verificación para elegir los datos que desee en la tabla Patient 
Lookup (Búsqueda de pacientes). Utilice las flechas arriba y abajo para ordenar las 
columnas.
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Cómo elegir los datos que se desea mostrar

• Utilice las casillas de verificación para seleccionar el tipo de datos 

que desea mostrar o para eliminar los datos que no desea mostrar en 

la tabla Patient Lookup (Búsqueda de pacientes).

NOTA: Los campos First
Name (Nombre) y Last

Name (Apellidos) no
pueden eliminarse.

Cómo cambiar el orden de las columnas  

• Para cambiar el orden de las columnas en la tabla Patient Lookup 

(Búsqueda de pacientes), seleccione la columna que desee mover 

y haga clic en las flechas arriba o abajo. (Las flechas situadas en 

la parte superior e inferior mueven una columna de datos hasta 

el comienzo o el final de la lista).

NOTA: La columna
de datos situada

en la parte superior
de la lista Column

Display Order (Orden de
presentación de las

columnas) aparecerá en
la primera columna de

la tabla Patient Lookup
(Búsqueda de

pacientes). La columna
de datos situada en la

parte inferior
aparecerá en la última

columna de la tabla.

Finalización de las preferencias de búsqueda de pacientes

• Cuando la lista Column Display Order (Orden de presentación de 

columnas) tenga todos los datos que desea en el orden correcto, 

haga clic en OK (Aceptar).

La tabla Patient Lookup (Búsqueda de pacientes) tendrá ahora los 

datos y el orden de columnas que acaba de seleccionar.

Preferencias para la generación de informes  

La tabla de datos aparece durante la fase de selección del proceso 

de generación de informes. Esta tabla debe incluir los datos que el 

profesional sanitario considere más útiles para decidir las fechas de 

las que desee ver informes Daily Detail (Detalles diarios).

NOTA: Para ver cómo se
aplican estas

preferencias a la tabla
de datos durante la

creación de informes,
consulte el apartado
Cómo seleccionar los

tipos de informes y las
fechas de inclusión, en la

página 54.

1 Seleccione Tools > Options (Herramientas > Opciones). 

2 Haga clic en la ficha Report Generation (Generación de informes). 

Aparece la ventana mostrada a continuación.

Flechas arriba y abajo
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Cómo elegir los datos que se desea mostrar

• Utilice las casillas de verificación para seleccionar el tipo de datos 

que desea mostrar o para eliminar los datos que no desea mostrar 

en la tabla de datos.

Cómo cambiar el orden de las columnas        

• Para cambiar el orden de las columnas de la tabla de datos, seleccione 

la columna que desee mover y haga clic en las flechas arriba o abajo. 

(Las flechas situadas en la parte superior e inferior mueven una columna 

de datos hasta el comienzo o el final de la lista).

NOTA: Los elementos
situados en la parte
superior de la lista

Column Order (Orden de
columnas) aparecerá en

la primera columna de
la tabla de datos. Los
elementos situados en

la parte inferior
aparecerán en la última
columna de la tabla de

datos.

Finalización de las preferencias para la generación de informes

• Cuando la lista Column Order (Orden de columnas) tenga todos los 

datos que desea en el orden correcto, haga clic en OK (Aceptar). 

La tabla de datos tendrá ahora los datos y el orden de columnas que 

acaba de seleccionar.

Utilice las casillas de verificación para elegir el tipo de datos que desee incluir 
en la tabla de datos. Utilice las flechas arriba y abajo para ordenar las columnas.

Flechas arriba y abajo
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Área de trabajo Profile (Perfil) 4

Contenido de este capítulo
• Antes de empezar: página 24

• Cómo añadir nuevos perfiles: página 25

• Cómo editar perfiles de pacientes: página 25

• Cómo eliminar datos de pacientes del programa: página 25

• Cómo conectar al programa CareLink Personal (opcional): página 26

Un perfil es similar a la portada de una historia clínica. Contiene 

información del paciente tal como el nombre y la fecha de nacimiento. 

Se requiere un perfil para poder recopilar datos de los dispositivos 

y utilizarlos para generar informes del tratamiento.

El área de trabajo Profile (Perfil) también le permite establecer una 

conexión a la cuenta del programa CareLink Personal de un paciente. 

Una vez establecida la conexión, puede recuperar los datos del paciente 

almacenados en el programa CareLink Personal en cualquier momento, 

sin la necesidad de que el paciente esté presente.

Antes de empezar

Si lo desea, puede personalizar los perfiles de pacientes para que sólo 

contengan el tipo de información que desea obtener. Si desea más 

información, consulte el apartado Preferencias de los perfiles de 

pacientes, en la página 20.

Además, se requieren un nombre de usuario y una contraseña al 

configurar la conexión a la cuenta del programa CareLink Personal de 

un paciente. El paciente debe estar presente para proporcionar estos 

datos.
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Cómo añadir nuevos perfiles

Cada vez que añada un paciente al programa CareLink Pro, deberá 

comenzar creando un perfil para el paciente. 

1 Seleccione File > New Patient (Archivo > Nuevo paciente) o haga 

clic en el botón ADD PATIENT (Añadir paciente). 

Aparece el área de trabajo Profile (Perfil) (vea el ejemplo mostrado 

en la página 11).

NOTA: Para añadir
o modificar campos en
el perfil del paciente,

haga clic en
>> customize fields

(Personalizar campos).
Consulte el apartado

Preferencias de los
perfiles de pacientes, en

la página 20.

2 Rellene los campos de la sección Patient Profile (Perfil del paciente). 

3 Haga clic en SAVE (Guardar).

Se añade el nuevo perfil de paciente a la base de datos del programa 

CareLink Pro. Aparecerá un mensaje que confirma que se ha guardado 

el perfil.

Si se intenta guardar un perfil de paciente y no se ha rellenado un 

campo obligatorio, aparecerá un mensaje junto a ese campo. No podrá 

guardar el perfil hasta que rellene el campo.

Cómo editar perfiles de pacientes

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté 

abierta.

2 Haga clic en EDIT (Modificar).

3 Modifique los datos de la sección Patient Profile (Perfil del paciente) 

según proceda.

4 Haga clic en SAVE (Guardar).

Aparecerá un mensaje que confirma que se ha guardado el perfil.

Cómo eliminar datos de pacientes del programa        

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté 

abierta. 

2 Compruebe que se trata del paciente que desea borrar. Cuando se 

borra un perfil de paciente también se borran sus datos de la base de 

datos del programa CareLink Pro; esta acción no puede deshacerse.

3 Haga clic en >> delete patient record (Borrar registro de paciente) 

encima de la sección de sincronización del perfil.

Aparecerá un mensaje que le advierte de que al borrar el registro se 

borrarán todos los datos del paciente. 

4 Haga clic en YES (Sí) para borrar el registro del paciente.

Botón Add Patient
(Añadir paciente)
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Cómo conectar al programa CareLink Personal 
(opcional)

Si el paciente lo permite, puede establecer una conexión a su cuenta 

del programa CareLink Personal. Esta herramienta de Internet permite 

a los pacientes transferir y guardar los datos de sus dispositivos 

y ejecutar diversos informes del tratamiento. 

Una vez conectado a la cuenta CareLink Personal del paciente, puede 

recuperar los datos de los dispositivos que el paciente haya guardado 

en ella y usarlos para crear informes CareLink Pro. Los informes pueden 

crearse en cualquier momento, incluso en el tiempo que transcurre 

entre las visitas a la consulta. También reduce la necesidad de leer 

el dispositivo del paciente a la consulta.

Si un paciente no tiene todavía una cuenta, el programa CareLink Personal 

puede enviarle un mensaje de correo electrónico invitándole a crear una. 

Cómo conectar a una cuenta existente  

NOTA: El paciente debe
estar presente para

realizar estos pasos.

1 Asegúrese de que está conectado a Internet.

2 Abra el área de trabajo Profile (Perfil) del paciente. 

3 Asegúrese de que estén rellenados todos los campos obligatorios 

de la sección Patient Profile (Perfil del paciente).

4 Haga clic en LINK TO EXISTING ACCOUNT (Conectarse a una cuenta 

existente).

Aparece la pantalla Log In (Inicio de sesión) del programa 

CareLink Personal.
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5 Pida al paciente que haga lo siguiente:

a. Rellene los campos Username (Nombre de usuario) y Password 
(Contraseña).

b. Haga clic en SIGN IN (Entrar). 

Se muestra la página Grant of Access (Concesión de acceso), basada 

en los ajustes del idioma y el domicilio del paciente.

6 Pida al paciente que haga lo siguiente:

a. Lea la sección Condiciones de uso.

b. Haga clic para marcar la casilla de verificación situada junto a la 
opción I agree to the Terms of Use above… (Acepto las condiciones 
de uso anteriormente expuestas). 

c. Haga clic en GRANT ACCESS (Conceder acceso).

d. Le avise cuando aparezca la página Thank You (Gracias).
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Puede imprimir las condiciones de uso para el paciente haciendo clic 

en el botón PRINT (Imprimir).

Ya está conectado a la cuenta del programa CareLink Personal del 

paciente. Consulte el apartado Cómo obtener datos de una cuenta con 

conexión, en la página 30.

Cómo enviar una invitación por correo electrónico 

Para enviar una invitación por correo electrónico a un paciente para 

crear una cuenta del programa CareLink Personal, siga los pasos descritos 

a continuación:

1 Abra el área de trabajo Profile (Perfil) del paciente. 

2 Asegúrese de que estén rellenados todos los campos obligatorios de 

la sección Patient Profile (Perfil del paciente).

3 Haga clic en SEND E-MAIL INVITATION TO PATIENT (Enviar invitación 

por correo electrónico al paciente).
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4 Asegúrese de que estén rellenados correctamente los campos 

Patient Name (Nombre del paciente), Email (Correo electrónico) 

y Language (Idioma).

5 Haga clic en SEND (Enviar). 

El área de estado del perfil del paciente confirma que se ha enviado 

el mensaje de correo electrónico.

Cómo desvincular la cuenta del programa CareLink Personal de un 
paciente del programa CareLink Pro

Puede desvincular la cuenta del programa CareLink Personal de un 

paciente del programa CareLink Pro. Esta opción sólo se encuentra 

disponible si el paciente ya ha estado conectado previamente. Impide 

que el programa CareLink Pro continue recuperando datos de la cuenta 

del programa CareLink Personal del paciente. No afecta a la cuenta 

personal existente del paciente del programa CareLink Personal.

1 Abra el registro del paciente y vaya al área de trabajo Profile (Perfil).

2 Haga clic en UNLINK ACCOUNT (Desvincular cuenta).

3 Haga clic en YES (Sí) en el mensaje de confirmación. El perfil 

personal del paciente ya no está conectado (Vinculado) al programa 

CareLink Pro.

El estado cambia a "No vinculado" y ahora se muestran los botones 

LINK TO EXISTING ACCOUNT (Conectarse a una cuenta existente) 

y SEND E-MAIL INVITATION TO PATIENT (Enviar invitación por correo 

electrónico al paciente).
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Cómo obtener datos de una cuenta con conexión            

Si está conectado a la cuenta del programa CareLink Personal de 

un paciente, los datos nuevos que pueda haber en esta cuenta se 

enviarán automáticamente cada vez que abra su perfil del paciente 

en el programaCareLink Pro. 

NOTA: Para asegurarse de
que este proceso se lleve

a cabo, vaya a Tools >
Options > General

(Herramientas >
Opciones > Generales)

y asegúrese de que haya
una marca de verificación

junto a la opción
"Synchronize with

Medtronic CareLink
Personal" (Sincronizar con

Medtronic CareLink
Personal).

Siga los pasos indicados a continuación para obtener los datos del 

programa CareLink Personal de un paciente en cualquier momento 

después de haber abierto su perfil de paciente:

1 Asegúrese de que el área de trabajo Profile (Perfil) del paciente esté 

abierta y de que esté conectada a Internet.

2 Seleccione Tools > Synchronize Patient Data (Herramientas > 

Sincronizar datos del paciente).

El icono de sincronización de la ficha del paciente gira. Cuando el icono 

se detenga, significa que el proceso ha finalizado.

NOTA: Si el paciente
ya no desea compartir

susCareLink Personal
datos, puede desactivar
esta opción desde el me
nú OPTIONS (Opciones).
Se mostrará un mensaje

para avisarle.

3 Los datos adicionales obtenidos del programa CareLink Personal 

aparecerán en los informes del paciente. 

Icono de sincronización
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Configuración del hardware 5

Contenido de este capítulo
• Antes de empezar: página 31

• Conexión de dispositivos: página 32

Este capítulo presenta diferentes esquemas que muestran cómo configurar 

el dispositivo de un paciente para que el ordenador pueda leer los datos 

de dicho dispositivo.

Necesita disponer del dispositivo del paciente para leer los datos 

directamente del mismo. No obstante, puede obtener los datos 

del dispositivo de la cuenta del programa CareLink™ Personal de 

un paciente sin tener que leerlos del mismo.   

Antes de empezar

Para leer los datos directamente desde un dispositivo, debe disponer 

del dispositivo del paciente y de los cables o dispositivos de comunicación 

necesarios para transferir los datos a su ordenador.
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Conexión de dispositivos

NOTA: Si desea más
detalles, siga las

instrucciones mostradas
por el programa

CareLink™ Pro durante
la lectura de los

dispositivos.

Observe el esquema general para hacerse una idea de cómo deben 

conectarse los dispositivos para que se comuniquen con el ordenador. 

Los esquemas presentados a continuación ilustran aspectos específicos 

de la comunicación de los dispositivos. 

NOTA: Este ejemplo
muestra el uso del USB

CareLink para la
comunicación entre la

bomba y el ordenador.

Descripción general de la configuración del hardware               

TM

CareLinkUSB

USB CareLink

PC

Bomba Paradigm
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Esquemas de las conexiones del hardware                                    

                      

Conexiones del PC

Puerto
USB

Puerto
serie
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conectar al
puerto en

serie del PC

ComLink para uso con bombas Paradigm

Componentes opcionales

Com-Station para uso con bombas MiniMed 508 y conexión de medidores
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Área de trabajo Devices 
(Dispositivos) 6

Contenido de este capítulo
• Antes de empezar: página 36

• Cómo añadir un dispositivo: página 36

• Cómo activar o desactivar un dispositivo: página 41 

• Cómo leer los datos de un dispositivo: página 43

La información necesaria para leer el dispositivo de un paciente (marca, 

modelo, número de serie, etc.) se almacena en el área de trabajo 

Devices (Dispositivos). Por tanto, no tiene que proporcionarla cada 

vez que lea los datos del dispositivo. 

Los dispositivos del área de trabajo Devices (Dispositivos) se almacenan 

en una de dos listas: Active Devices (Dispositivos activos) o Inactive 

Devices (Dispositivos inactivos). Cuando se añade un dispositivo, se 

agrega automáticamente a la lista Active Devices (Dispositivos activos). 

Sólo puede leer los datos de los dispositivos que aparezcan en la lista 

Active Devices (Dispositivos activos). Estos probablemente serán los 

dispositivos que utiliza actualmente el paciente. 

Los demás dispositivos pertenecientes al paciente que no se estén 

utilizando actualmente pueden guardarse en la lista Inactive Devices

(Dispositivos inactivos). La información se guardará en archivo. Estos 

dispositivos pueden activarse en cualquier momento.
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Antes de empezar

Para poder abrir el área de trabajo Devices (Dispositivos) para un 

paciente debe tener un perfil guardado en el programa. Consulte 

el Capítulo 4, Área de trabajo Profile (Perfil).

Para añadir un dispositivo o leer los datos directamente de él, debe 

estar en comunicación con el ordenador. Consulte en el Capítulo 5, 

Configuración del hardware, cómo configurar los dispositivos para que 

establezcan comunicación con el ordenador.

Cómo añadir un dispositivo

Puede obtener los datos de la cuenta del programa CareLink Personal 

del paciente para los dispositivos que no hayan sido añadidos todavía. 

Estos dispositivos se añadirán automáticamente al sincronizar los datos 

entre el programa CareLink Personal y el programa CareLink Pro.

NOTA: Sólo puede haber
una bomba activa por
paciente. Si se añade
una nueva bomba, se

pasará la bomba
existente a la lista de
dispositivos inactivos.

Cómo añadir una bomba de Medtronic o un monitor Guardian          

1 Asegúrese de que el dispositivo que está añadiendo esté configurado 

para comunicarse con el ordenador. (Consulte el Capítulo 5, 

Configuración del hardware, para ver los pasos para la conexión).

2 Haga clic en la pestaña del paciente o haga doble clic sobre su 

nombre en la tabla Patient Lookup (Búsqueda de pacientes).

3 Haga clic en DEVICES (Dispositivos) para acceder al área de trabajo 

Devices (Dispositivos) del paciente (vea el ejemplo mostrado en la 

página 11).

4 Haga clic en ADD DEVICE (Añadir dispositivo).

5 Seleccione Medtronic Pump/Guardian (Bomba de Medtronic/Guardian). 

Aparece el asistente Add Medtronic Pump/Guardian (Añadir bomba 

de Medtronic/Guardian).

Botón DEVICES
(Dispositivos)
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NOTA: El modelo de la
bomba aparece

indicado en la parte
posterior de la bomba

o en la pantalla de
estado de la bomba.

6 Selección el botón de opción para especificar el dispositivo que 

desea añadir. 

Si ha seleccionado la opción MiniMed 508 pump (Bomba MiniMed 508), 

vaya al paso 9.

7 Haga clic en NEXT (Siguiente). Aparece la página Serial Number

(Número de serie).

NOTA: Se mostrará un
mensaje de error si no

introduce el número de
serie correcto. Vea los
ejemplos mostrados en

esta página
y compruebe que está

introduciendo los
caracteres correctos
indicados en la parte

posterior de la bomba.
Si fuera necesario,

vuelva a escribir los
seis caracteres.

8 Utilice los ejemplos mostrados en esta página para localizar el 

número de serie de seis caracteres del dispositivo que desea añadir. 

(Si necesita más ayuda para localizarlo, haga clic en >> learn more
[más información]). Escriba los seis caracteres en el campo Device 

Serial Number (Número de serie del dispositivo).

9 Haga clic en NEXT (Siguiente). Aparece una página Communication

Options (Opciones de comunicación) similar a la mostrada 

a continuación.
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10 Haga clic en el menú desplegable Choose Port (Elegir puerto) 

y seleccione el puerto del ordenador al que se conecta el dispositivo 

ComLink, Paradigm Link®, USB CareLink o Com-Station. Si no está 

seguro de qué puerto elegir, seleccione Auto Detect (or USB)
(Detectar automáticamente [o USB]). 

11 Haga clic en NEXT (Siguiente). Aparece la página Test Connection

(Comprobar conexión), similar a la mostrada a continuación.

12 Siga las instrucciones del dispositivo y haga clic en TEST (Comprobar).

Aparece un mensaje que le informa si la conexión ha sido satisfactoria. 

Si ha sido así, vaya al siguiente paso. 

NOTA: Esta
comprobación no lee

datos de la bomba,
simplemente verifica

que las comunicaciones
sean correctas entre la
bomba y el ordenador.

Si no lo ha sido, asegúrese de que el hardware entre el dispositivo 

y el ordenador esté correctamente conectado. Además, haga clic en 

BACK (Atrás) en las páginas del asistente para asegurarse de que los 

datos del dispositivo introducidos son correctos.

13 Haga clic en DONE (Finalizar).

Se añade la bomba a la lista Active Devices (Dispositivos activos) del 

paciente.
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Cómo añadir un medidor           

1 Haga clic en la pestaña del paciente o haga doble clic sobre su nombre 

en la tabla Patient Lookup (Búsqueda de pacientes).

2 Asegúrese de que el medidor que está añadiendo esté en comunicación 

con el ordenador. (Consulte el Capítulo 5, Configuración del 

hardware, para ver los pasos para la conexión).

3 Haga clic en DEVICES (Dispositivos) para acceder al área de trabajo 

Devices (Dispositivos) del paciente (vea el ejemplo mostrado en la 

página 11).

4 Haga clic en el botón ADD DEVICE (Añadir dispositivo).

5 Seleccione Blood Glucose Meter (Medidor de glucosa). Aparece el 

asistente Add Blood Glucose Meter (Añadir medidor de glucosa).

6 Haga clic en el botón de opción para seleccionar la marca correcta 

del medidor.

7 Haga clic en NEXT (Siguiente). Aparece la página Meter Model

(Modelo del medidor); esta página será diferente según el fabricante 

del medidor.
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8 Haga clic para seleccionar el modelo de medidor que desea añadir. 

9 Haga clic en NEXT (Siguiente). Aparece la página Communication

Options (Opciones de comunicación).

NOTA: Sólo pueden
seleccionarse las

opciones válidas para el
medidor que se está

añadiendo.

10 Haga clic en el menú desplegable Choose Port (Elegir puerto) 

y seleccione el puerto del ordenador al que se conecta el dispositivo 

ComLink, Paradigm Link® o USB CareLink. Si no está seguro de qué 

puerto elegir, seleccione Auto Detect (or USB) (Detectar 

automáticamente [o USB]). 

11 Haga clic en NEXT (Siguiente). Aparece la página Test Connection

(Comprobar conexión).
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12 Siga las instrucciones para el medidor y haga clic en TEST 

(Comprobar).

Aparece un mensaje que le informa si la conexión ha sido 

satisfactoria. Si ha sido así, vaya al siguiente paso. 

Si no lo ha sido, asegúrese de que el hardware entre el dispositivo 

y el ordenador esté correctamente conectado. Además, haga clic 

en BACK (Atrás) en el asistente para asegurarse de que los datos 

introducidos sean correctos.

13 Haga clic en DONE (Finalizar).

Se añade el medidor a la lista Active Devices (Dispositivos activos) 

del paciente.

Cómo activar o desactivar un dispositivo

Los dispositivos del paciente pueden moverse entre las listas Active 

Devices (Dispositivos activos) e Inactive Devices (Dispositivos inactivos) 

según sea necesario. Un dispositivo debe estar activo para poder leer 

datos de él. 

Puede tener cuantos medidores que desee en la lista Active Devices

(Dispositivos activos), pero sólo puede tener una bomba. Asegúrese 

de que desea desactivar la bomba activa actual antes de añadir una 

nueva.
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Cómo desactivar un dispositivo              

1 Haga clic en la pestaña del paciente o haga doble clic sobre su 

nombre en la tabla Patient Lookup (Búsqueda de pacientes).

2 Haga clic en DEVICES (Dispositivos) para acceder al área de trabajo 

Devices (Dispositivos) del paciente.

NOTA: Es posible que
los dispositivos

aparezcan en la lista
con el nombre de un

dispositivo equivalente.
Consulte el apartado

Dispositivos
equivalentes, en la

página 5.

3 Haga clic en >> make this device inactive (Desactivar este 

dispositivo) debajo del dispositivo que desee desactivar.

El dispositivo pasará a la lista Inactive Devices (Dispositivos 

inactivos).

Cómo activar un dispositivo               

1 Haga clic en la pestaña del paciente o haga doble clic sobre su 

nombre en la tabla Patient Lookup (Búsqueda de pacientes).

2 Haga clic en DEVICES (Dispositivos). Aparece el área de trabajo 

Devices (Dispositivos) del paciente.

3 Haga clic en >> activate this device (Activar este dispositivo) 

debajo del dispositivo que desee activar.

El dispositivo pasará a la lista Active Devices (Dispositivos activos).

Cómo borrar un dispositivo             

Los pasos descritos a continuación borrarán un dispositivo y sus datos 

del área de trabajo Devices (Dispositivos) y del programa CareLink Pro:

1 Haga clic en la pestaña del paciente o haga doble clic sobre su 

nombre en la tabla Patient Lookup (Búsqueda de pacientes).

2 Haga clic en DEVICES (Dispositivos) para acceder al área de trabajo 

Devices (Dispositivos) del paciente.

3 Asegúrese de que el dispositivo se encuentre en la lista Inactive Devices

(Dispositivos inactivos). Si no es así, haga clic en >> Inactivate this 
device (Desactivar este dispositivo) en la lista actual.

4 Haga clic en >> delete this device (Borrar este dispositivo) debajo 

del dispositivo que desee borrar.

Aparecerá un mensaje que le advierte de que se borrarán del registro 

del paciente el dispositivo y todos sus datos.

5 Haga clic en YES (Sí) para borrar el dispositivo. 
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El dispositivo y sus datos se borran del área de trabajo Devices

(Dispositivos) y del programa CareLink Pro. Los datos de este 

dispositivo ya no están disponibles para su uso en informes.

Cómo leer los datos de un dispositivo

Una forma de obtener los datos de un dispositivo es conectarse 

a la cuenta existente del programa CareLink Personal del paciente. 

(Consulte el apartado Cómo conectar al programa CareLink Personal 

(opcional), en la página 26). Otra forma es leerlos directamente del 

dispositivo, tal como se describe en este capítulo. 

El programa CareLink Pro puede leer los datos del dispositivo de un 

paciente si el dispositivo está en la lista Active Devices (Dispositivos 

activos) y está en comunicación con el ordenador. Una vez obtenidos 

los datos, puede utilizarlos para crear informes que ayuden a evaluar 

la gestión del tratamiento del paciente. (Consulte el Capítulo 7, Área 

de trabajo Reports (Informes), para obtener más información sobre 

los informes).

A continuación se incluyen algunos de los tipos de información que el 

programa CareLink Pro reúne desde una bomba de insulina durante un 

proceso de carga:  

• Diversos parámetros de la bomba, como el modo de alerta, 

el volumen de los pitidos y la presentación de la hora

• Cantidades de insulina basal administradas

• Episodios de bolus y cantidades administradas

• Entradas de la función Bolus Wizard

• Cantidades de cebado

• Períodos de suspensión

• Lecturas de glucosa del sensor durante un período de tiempo, 

en bombas con funciones de sensor

El sistema también puede reunir datos de sistemas Guardian 

REAL-Time, incluyendo los siguientes:

• Lecturas de los valores del sensor (Sen)

• Valores de coeficiente del sensor

• Factores de calibración del sensor

• Marcadores de comida

• Inyecciones de insulina
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Además, diversa información almacenada en un medidor de glucosa 

en sangre puede descargarse al programa durante una lectura del 

dispositivo.

ADVERTENCIA: Cancele o termine los bolus activos o los índices basales temporales 
y resuelva las alarmas activas. Se suspenderá el funcionamiento de la bomba durante 
la lectura. Una vez concluida la lectura, asegúrese de que se haya reanudado el 
funcionamiento de la bomba.

PRECAUCIÓN: No utilice el control remoto de la bomba durante la lectura de la misma. 

Si la carga de la pila de la bomba está baja, la bomba no enviará datos al PC. Sustituya 
la pila si el indicador de estado muestra que la carga de la pila está baja.    

1 Haga clic en la pestaña del paciente o haga doble clic sobre su 

nombre en la tabla Patient Lookup (Búsqueda de pacientes).

2 Asegúrese de que el dispositivo del paciente esté en comunicación 

con el ordenador. (Consulte el Capítulo 5, Configuración del 

hardware).

3 Haga clic en DEVICES (Dispositivos) para acceder al área de trabajo 

Devices (Dispositivos) del paciente.

NOTA: Es posible que
los dispositivos

aparezcan en la lista
con el nombre de un

dispositivo equivalente.
Consulte el apartado

Dispositivos
equivalentes, en la

página 5.

4 Localice el dispositivo del que desea obtener datos en la lista Active

Devices (Dispositivos activos) y asegúrese de que los datos del campo 

Choose port (Elegir puerto) sean correctos.

– Para las bombas, haga clic en el menú desplegable Amount of 
Data (Cantidad de datos) y seleccione la cantidad de datos de 
la bomba que desea que lea el programa CareLink Pro.

5 Haga clic en el botón READ DEVICE (Leer dispositivo) asociado.

6 Siga las instrucciones específicas del dispositivo y haga clic 

en OK (Aceptar).

7 El programa CareLink Pro muestra una barra de progreso que se 

actualiza para mostrar el porcentaje completado de la lectura del 

dispositivo.
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8 Si hace clic en CANCEL (Cancelar) durante la lectura del dispositivo, 

se mostrará un mensaje para advertirle de que si se cancela la 

acción podrían perderse todos los datos leídos hasta ese momento. 

Necesitará hacer clic en el botón READ DEVICE (Leer dispositivo) (paso 5)

para reiniciar el proceso de carga.

– Para cancelar el proceso, haga clic en YES (Sí). 

– Para continuar la lectura de los datos del dispositivo, haga clic 
en NO.

Cuando el programa concluya la lectura de los datos del dispositivo, 

aparecerá un mensaje que confirma que la lectura del dispositivo ha 

finalizado.

9 Haga clic en OK (Aceptar). 

– Para las bombas de insulina, siga las instrucciones para sacarlas 
del modo de suspensión.

Si CareLink Pro no puede obtener datos del dispositivo, consulte 

el Capítulo 9, Resolución de problemas, para obtener más ayuda.
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Área de trabajo Reports 
(Informes) 7

Contenido de este capítulo
• Antes de empezar: página 46

• Cómo crear informes: página 47

• Acerca de los informes: página 56

• Cómo exportar datos: página 58

El área de trabajo Reports (Informes) del programa CareLink™ Pro

le permite transformar los datos obtenidos de los dispositivos en 

información clínicamente útil. En el apartado Acerca de los informes, 

en la página 56, se indican los tipos de informes que puede crear. 

Los informes pueden generarse en la pantalla, enviarse directamente 

a una impresora o guardarse como archivos TIFF o PDF que puede 

adjuntar a una historia clínica electrónica. Puede generar varios tipos 

de informes en una sola operación.

Los datos mostrados en estos informes proceden de los dispositivos del 

paciente, de su cuenta del programa CareLink Personal o de ambas fuentes. 

Antes de empezar

Si desea reflejar un período de tiempo en un informe, debe tener los 

datos del dispositivo del paciente correspondientes a dicho período. 

Es posible que también necesite tener el dispositivo del paciente conectado 

al ordenador para obtener datos recientes antes de generar informes.

Lea atentamente el paso Comprobación de la configuración de 

los informes antes de generar un informe. Ahí puede configurar 

detalladamente un informe para registrar los datos que desee del paciente.
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Cómo crear informes

Los siguientes apartados describen los pasos necesarios para crear 

uno o más informes.

Cómo abrir el área de trabajo Reports (Informes)     

1 Haga clic en la lengüeta del paciente o haga clic en el botón OPEN 

PATIENT (Abrir paciente) y haga doble clic en su nombre.

Aparece el área de trabajo Reports (Informes) (vea el ejemplo 

mostrado en la página 11).

NOTA: Para asegurarse
de que dispone de los
datos del dispositivo

más recientes
procedentes de la

cuenta del programa
CareLink Personal del
paciente, haga clic en

SYNC DATA (Sincronizar
datos).

Cómo seleccionar el período del informe        

1 Para cambiar el período de tiempo reflejado en los informes, haga 

clic en el menú desplegable Duration (Duración) y seleccione la cantidad 

de tiempo que desee. (La duración máxima es de 12 semanas).

2 Las fechas desde y hasta se definen automáticamente a menos 

que seleccione la opción custom data range (Intervalo de fechas 

personalizado). 

NOTA: Si selecciona un
intervalo de fechas

superior al permitido,
se mostrará un mensaje

de error. Ajuste la
duración o las fechas.

Si desea un intervalo de fechas personalizado, haga clic en los menús 

desplegables From (Desde) o Through (Hasta) y seleccione el día, el 

mes o el año que desee. 

Calendario de datos

El área del calendario de datos del área de trabajo Reports (Informes) 

muestra un intervalo de tres meses de información para informes. 

Muestra una lista de los dispositivos y la cantidad de datos del 

dispositivo contenida en los tres meses seleccionados. También 

muestra la duración del período del informe para los tres meses 

seleccionados.

Open Patient (Abrir paciente)
botón

datos de dispositivos
período del informe

calendario de datos
meses
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Si existe una superposición de los datos de los dispositivos y del 

período de informe, significa que dispone de datos de parte del 

período del informe mostrado o de todo el período.

El área del calendario de datos muestra inicialmente los tres meses 

más recientes. Para ver otros meses, haga clic en los botones de 

flecha situados a ambos extremos de los meses.

Cómo seleccionar los datos originales que se desea incluir       

1 Si el paciente utiliza un medidor de glucosa vinculado a su bomba 

de insulina, haga clic para elegir una de las siguientes opciones para 

generar un informe con los datos del medidor de glucosa: 

– in the pump (en la bomba): las ventajas de esta selección son que 
sólo tiene que leer los datos de la bomba del paciente, que las 
lecturas de glucosa en sangre llevan la fecha y la hora registradas 
por la bomba y que las lecturas se vinculan directamente a los 
cálculos de la función Bolus Wizard utilizados. Un inconveniente 
es que si existen problemas de comunicación entre la bomba y el 
medidor vinculado, es posible que no se incluyan en el informe las 
lecturas de glucosa en sangre correspondientes a ese período de 
tiempo. Además, para las bombas MiniMed Paradigm anteriores al 
Modelo 522/722, no se incluyen en los informes las lecturas de 
glucosa en sangre derivadas de los cálculos de la función Bolus 
Wizard sobre las que no se actúa.

– in the link meter(s) (en el medidor vinculado): la ventaja de esta 
selección es que se incluyen en el informe todas las lecturas 
guardadas en el medidor vinculado. El inconveniente es que para 
relacionar los datos del medidor y de la bomba, debe haberse 
asegurado de que los relojes de la bomba y del medidor están 
sincronizados entre sí. También debe leer los datos de la bomba 
y del medidor vinculado por separado.

Superposición entre los datos de los 
dispositivos y el período del informe

botones de flecha
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2 Para añadir los datos de un dispositivo a los informes, seleccione 

la casilla de verificación situada junto al dispositivo en cuestión. 

No puede añadir dispositivos que hayan sido excluidos a consecuencia 

de la selección realizada en el paso 1. Para cambiar esto, seleccione 

la otra opción del medidor vinculado.

3 Para excluir los datos de un dispositivo de los informes, elimine 

la marca de la casilla de verificación situada junto al dispositivo 

en cuestión. 

No puede eliminar las marcas de verificación relacionadas con 

la opción seleccionada en el paso 1. Para cambiar esto, seleccione 

la otra opción del medidor vinculado.

Cómo comprobar los datos de los dispositivos

1 Compruebe en el área del calendario de datos del área de trabajo 

Reports (Informes) si el período del informe se superpone con los 

datos de los dispositivos (vea el ejemplo mostrado en la página 48).

2 Si las barras se superponen en todo el período del informe, dispone 

de datos para los informes. Puede hacer clic en NEXT (Siguiente) e ir 

al apartado Comprobación de la configuración de los informes, en 

la página 51.

3 Si las barras no se superponen, o si la superposición no es suficiente, 

tiene dos opciones:

– Ajustar el período del informe (consulte el apartado Cómo 
seleccionar el período del informe, en la página 47).

– Obtener datos adicionales de los dispositivos (consulte el 
apartado Cómo obtener datos adicionales de los dispositivos, 
en la página 49).

Cómo obtener datos adicionales de los dispositivos         

1 Para obtener más datos de un dispositivo, haga clic en el botón READ 

DEVICE (Leer dispositivo) asociado al dispositivo.

Se muestra la barra Read Device (Leer dispositivo).
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ADVERTENCIA: Cancele o termine los bolus activos o los índices basales temporales 
y resuelva las alarmas activas. Se suspenderá el funcionamiento de la bomba durante 
la lectura. Una vez concluida la lectura, asegúrese de que se haya reanudado el 
funcionamiento de la bomba.

PRECAUCIÓN: No utilice el control remoto de la bomba durante la lectura de la misma. 

Si la carga de la pila de la bomba está baja, la bomba no enviará datos al PC. Sustituya 
la pila si la pantalla de estado del dispositivo indica que la carga de la pila está baja.    

2 Compruebe que los datos del campo Choose port (Elegir puerto) sean 

correctos para este dispositivo. 

Para cambiar este valor, haga clic en el menú desplegable del campo 

y seleccione un valor diferente.

3 Asegúrese de que el dispositivo está conectado al ordenador. 

4 Si el dispositivo es una bomba, puede especificar la cantidad de datos 

que desea obtener de ella. Haga clic en el desplegable Amount of 

Data (Cantidad de datos) y seleccione una cantidad.

NOTA: Si selecciona All
available data (Todos los

datos disponibles), el
sistema leerá todos los
datos de la bomba. Se

sobrescribirán los datos
duplicados que haya en

el sistema.

5 Haga clic en READ DEVICE (Leer dispositivo). Lea detenidamente 

el mensaje mostrado, ya que proporciona instrucciones específicas 

para leer la bomba.

6 Siga las instrucciones y haga clic en OK (Aceptar). 

Se muestra la barra de progreso de lectura del dispositivo.

Puede decidir cancelar la lectura en cualquier momento haciendo 

clic en CANCEL (Cancelar).

Aparecerá un mensaje que confirma que la lectura ha finalizado.

7 Haga clic en OK (Aceptar).

Los datos del dispositivo se visualizarán entonces en el calendario de 

datos.

Barra READ DEVICE (Leer dispositivo)

botón READ DEVICE 
(Leer dispositivo)
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8 Haga clic en NEXT (Siguiente) en la parte superior del área de 

trabajo Reports (Informes).

Se muestra el paso Verify Report Settings (Comprobar la configuración 

de los informes). Esto le permite asegurarse de que la configuración 

para este paciente es correcta antes de generar el informe.

Comprobación de la configuración de los informes

1 Asegúrese de que los valores del área Glucose Target (Objetivo de 

glucosa) son los deseados. Escriba estos valores o haga clic en las 

flechas arriba o abajo de los campos Low (mínimo) y High (máximo) 

para aumentar o disminuir los valores.

NOTA: Puede tener
hasta cinco períodos de

comida. Los períodos
predeterminados son

desayuno, comida y cena.

2 Para añadir un nuevo período de comida, haga clic en ADD MEAL 

(Añadir comida). Para modificar un período de comida existente, 

haga clic en cualquier punto del período de comida a lo largo de 

la línea temporal.

El editor Meal Period (Período de comida), situado bajo la línea 

temporal, se activa.

línea
temporal

período de comida 

campos para editar los períodos de comida

períodos de acostarse y despertarse
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3 Introduzca texto o haga clic en las flechas para seleccionar 

la configuración que desee.

NOTA: Si sólo desea
utilizar esta

configuración para esta
comida, elimine la

marca de la casilla de
verificación situada

junto a la opción Use
these parameters for all

of this patient’s meals
(Utilizar estos

parámetros para todas
las comidas de este

paciente).

– Meal Name (Nombre de la comida): nombre que desea asignar 
al período de comida.

– Meal Time Period (Período de tiempo de comida): horas entre 
las que tiene lugar la comida.

– Pre-Meal BG Target (Objetivo de glucosa en sangre antes 
de la comida) (mg/dl o mmol/l): límites inferior y superior del 
intervalo del objetivo de glucosa antes de la comida del paciente.

– Pre-Meal Analysis Period (Período de análisis previo a la 
comida): período de tiempo en el que la glucosa será analizada, 
antes del inicio de una comida. Las lecturas de glucosa registradas 
durante este tiempo se utilizan para un análisis de informe 
detallado.

– Post-Meal BG Target (Objetivo de glucosa en sangre después 
de la comida) (mg/dl o mmol/l): límites inferior y superior del 
intervalo del objetivo de glucosa después de la comida del 
paciente.

– Post-Meal Analysis Period (Período de análisis posterior a la 
comida): período de tiempo en el que la glucosa será analizada 
después de una comida. Las lecturas de glucosa registradas 
durante este tiempo se utilizan para un análisis de informe 
detallado.

NOTA: Los períodos de
las comidas no pueden
superponerse, pero las
líneas inicial y final de

los distintos períodos
pueden estar contiguas.
Los períodos de comida

deben tener una
duración de al menos

60 minutos.

Puede cambiar la duración de un período de comida existente o del 

período de despertarse o acostarse haciendo clic en los tiradores 

inicial o final y arrastrándolos y soltándolos en la línea temporal. 

seleccione el tirador inicial o final y arrástrelo y suéltelo en la línea temporal

línea temporal

marcadores de lecturas del medidor
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4 Para utilizar la configuración de esta comida para las demás comidas 

del paciente, asegúrese de que esté seleccionada la casilla de 

verificación situada junto a la opción Use these parameters for 

all of this patient’s meals (Utilizar estos parámetros para todas 

las comidas de este paciente).

5 Cuando haya finalizado de crear o editar un período de comida, haga 

clic en SAVE (Guardar).

6 Para borrar un período de comida, haga clic en DELETE MEAL (Borrar 

comida). Haga clic en DELETE (Borrar) cuando se le pida que 

confirme la acción.

7 El programa CareLink Pro puede recordar esta configuración para 

este paciente la siguiente vez que genere un informe para él. Para 

guardar la configuración para este paciente, haga clic en SAVE 

SETTINGS (Guardar configuración).

8 Haga clic en NEXT (Siguiente) en la parte superior del área de 

trabajo Reports (Informes). 

Este es el paso Select and Generate Reports (Seleccionar y generar 

informes) del proceso. Proporciona una lista de tipos de informes 

y una tabla de datos que le ayuda a incluir o excluir ciertos días de 

datos del/de los informe(s) Daily Detail (Detalles diarios). 

9 Para imprimir una pantalla, haga clic en el icono PRINT (Imprimir).

Tabla de datos

Icono de
impresión
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NOTA: Para modificar la
presentación de la

tabla de datos, haga
clic en >> customize

columns (Personalizar
columnas). Consulte el
apartado Preferencias
para la generación de

informes, en la
página 22.

Cómo seleccionar los tipos de informes y las fechas de inclusión           

1 Seleccione la casilla de verificación situada junto a los informes que 

desee incluir en el conjunto de informes.

2 Si se han leído los datos de una bomba o de un monitor Guardian más 

de una vez durante este período de informe, es posible que haya 

varias imágenes del dispositivo: 

a. Asegúrese de que esté seleccionada la casilla de verificación 
situada junto a la opción Device Settings Snapshot (Imagen de la 
configuración del dispositivo). 

b. Haga clic en la flecha de menú desplegable y seleccione la fecha 
y la hora de una imagen. 

– Bombas: Seleccione una captura de imagen de la bomba del 
paciente.

– Guardian: Seleccione una captura de imagen del monitor 
Guardian del paciente. 

Si el campo aparece atenuado, significa que no hay imágenes 

disponibles para el período del informe.

3 Recorra la tabla de datos para revisar la información de los informes 

Daily Detail (Detalles diarios) disponible. 

– Puede ordenar los datos en cada columna. Haga clic en el 
encabezado de la columna para ordenar los datos en orden 
ascendente. Haga clic de nuevo en el encabezado para ordenar 
los datos en orden descendente.

NOTA: Si no hay datos
para una fecha

concreta, no podrá
seleccionar esa fecha.

4 Seleccione la casilla de verificación de las filas de la tabla de datos 

para las fechas para las que desee un informe Daily Detail Report

(Informe de detalles diarios). 

– Para incluir o excluir todas las fechas del informe Daily Detail
(Detalles diarios) con un solo clic, seleccione la casilla de 
verificación situada en la parte superior de la columna de casillas 
de verificación de la tabla de datos.
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Cómo generar informes                                   

1 Una vez que haya verificado las selecciones para los informes, haga 

clic en GENERATE REPORTS (Generar informes) en la parte superior 

del área de trabajo Reports (Informes).

Se presenta una lista de opciones.

2 Seleccione una opción para mostrar una vista previa de los informes, 

imprimirlos o guardarlos.

Si ha seleccionado la opción Preview (Vista previa), aparecerá la 

ventana Report Preview (Vista previa de informe).

3 Haga clic en los botones de flecha para desplazarse por los informes 

que tengan varias páginas.

4 Haga clic en uno de los otros botones en la parte superior de la 

ventana Report Preview (Vista previa de informe) para guardar 

o imprimir el/los informe(s).

5 Para cerrar esta ventana, haga clic en el botón CLOSE (Cerrar) 

situado en la esquina superior derecha de la ventana.CLOSE (Cerrar)
vista previa

botón
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Acerca de los informes         

Este apartado proporciona una descripción de cada informe. En la guía 

de referencia para informes se presenta información más detallada 

sobre los componentes de los informes, así como ejemplos de los 

informes. Puede acceder a la guía de referencia para informes 

a través del programa CareLink Pro:

1 Help > View Report Reference Guide (PDF) (Ayuda > Ver guía 
de referencia para informes [PDF]).

2 Seleccione un idioma para la guía de referencia para informes.

Los informes del programa CareLink Pro tienen los siguientes 

elementos en común: 

• Encabezado del informe: el encabezado del informe contiene 

información de identificación, como el nombre del informe, el 

nombre del paciente y el origen de los datos.

• Niveles de carbohidratos y glucosa en sangre: en los gráficos 

y tablas las unidades de carbohidratos se muestran en cursiva 

y los niveles de glucosa en sangre se muestran en negrita.

• Datos del fin de semana: los días del fin de semana se muestran 

en negrita para poder identificarlos fácilmente.

• Leyendas: en la parte inferior de cada informe se muestra una 

leyenda de los símbolos. Aunque un símbolo puede ser utilizado 

en varios informes, las leyendas son exclusivas para cada informe.

Adherence Report (Informe de cumplimiento)        

Este informe presenta datos que describen cómo se utilizan las 

bombas de insulina y los sensores, así como el comportamiento del 

paciente en relación con su tratamiento. Responde a la pregunta 

"¿Había suficientes datos para obtener una idea precisa de cómo 

utiliza el paciente la bomba de insulina y el sensor, si procede?". 

También responde a la pregunta "¿Cumplen los pacientes el tratamiento 

tal como se les ha indicado?". Indica también si puede ser necesario 

hablar con el paciente acerca de la forma en que está controlando su 

diabetes.
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Sensor and Meter Overview Report 
(Informe de resumen del medidor y del sensor)       

El informe Sensor and Meter Overview Report (Informe general del 

medidor y del sensor) proporciona una representación gráfica de 

los niveles diarios y las medias de glucosa del paciente, incluido un 

desglose por horas durante 24 horas y su relación con las comidas 

y los patrones de sueño. También se incluyen estadísticas sobre las 

lecturas de glucosa y el uso de insulina por el paciente. 

Si se dispone de datos del sensor se genera un análisis similar de 

dichos datos como primera página del informe. Si no se dispone de 

datos del sensor, la primera página será la página de análisis de los 

datos del medidor.

Las páginas finales del informe muestran el nivel día a día y la calidad 

del control de la glucemia, de los carbohidratos y de la insulina del 

paciente. Cada página muestra la variación de ese control cada día 

durante todo el período del informe, con un máximo de 14 días por página.

Logbook Report (Informe Libro de registro)        

El informe Logbook Report (Informe Libro de registro) proporciona 

datos de insulina, de carbohidratos y de glucosa del medidor para 

cada día del período del informe. Ofrece un diario de los eventos 

registrados cada hora, así como los promedios y totales diarios. 

Cada página contiene un máximo de 14 días. Si el período del informe 

es superior a 14 días, se generarán páginas adicionales.

Device Settings Snapshot  
(Imagen de la configuración del dispositivo)        

Este informe presenta una imagen de la configuración de la bomba 

o del monitor Guardian REAL-Time del paciente para una fecha y una 

hora específicas. Puede ayudarle a comprender otros informes 

o simplemente documentar la configuración del paciente. 

La configuración de la bomba o del monitor sólo se registra durante 

la lectura del dispositivo. Si no se ha leído el dispositivo durante el 

período del informe, no se dispondrá de ajustes de configuración.

Daily Detail Report (Informe de detalles diarios)

El informe Daily Detail Report (Informe de detalles diarios) muestra 

los datos de glucosa, las cantidades de carbohidratos y la utilización 

de insulina por el paciente para el día seleccionado. Se genera un 

informe diferente para cada día seleccionado en la tabla de datos.
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El informe Daily Detail Report (Informe de detalles diarios) proporciona 

información detallada de cada día seleccionado. Le permite centrarse 

en un día determinado si piensa que ese día ocurrió algo importante 

para el tratamiento del paciente.

Cómo exportar datos

Puede exportar datos de dispositivos que el programa CareLink Pro 

haya adquirido y guardado. Esto le permite disponer de todos los 

datos de los dispositivos de un paciente para utilizarlos para generar 

estadísticas o crear informes o gráficos especializados. El archivo 

.csv puede importarse en Microsoft Excel o en ciertos programas 

de estadísticas clínicas en los que puede manipular los datos.

El archivo .csv contiene datos que registran las acciones del 

dispositivo. Por ejemplo, presenta una lista del registro de las 

lecturas del medidor, la bomba que recibió el valor de la lectura 

del medidor o el cambio del índice basal.

NOTA: Se trata de una
función avanzada

y requiere que esté
familiarizado con los

datos sin procesar del
dispositivo. También

requiere un dominio del
programa de software

en el que importe el
archivo .csv.

Siga los pasos descritos a continuación para utilizar la función de 

exportación del programa CareLink Pro:

1 Haga clic en la lengüeta del paciente o haga clic en el botón OPEN 

PATIENT (Abrir paciente) y haga doble clic en su nombre.

2 Asegúrese de que aparece el área de trabajo Reports (Informes).

3 Utilice los campos Duration (Duración) o From/Through (Desde/Hasta) 

para definir las fechas y la duración del informe.

La duración máxima que puede seleccionar es 12 semanas.

4 Haga clic en el vínculo export selected data (Exportar datos 

seleccionados).

Aparece el cuadro de diálogo Export Data to CSV File (Exportar datos 

a archivo CSV).

vínculo export 
selected data 
(Exportar datos 
seleccionados)
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5 Para cambiar el lugar en el que se guardará el archivo .csv en el 

ordenador, haga clic en la flecha situada a la derecha del campo 

Save in (Guardar en) y seleccione una ubicación.

6 Si desea cambiar el nombre del archivo, escríbalo en el cuadro File

name (Nombre del archivo).

7 Haga clic en SAVE (Guardar).

NOTA: Si desea más
información sobre los
datos presentados en

los archivos CSV,
consulte el apartado
Datos de los archivos
CSV, en la página 71.

El archivo .csv ya está guardado en el ordenador en la ubicación 

seleccionada. A continuación puede importarlo en cualquier programa 

que sea compatible con este tipo de archivo.
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Administración del programa 8

Contenido de este capítulo
• Antes de empezar: página 60

• Actualizaciones del programa: página 61

• Copia de seguridad y restauración de la base de datos: página 62

Es importante que haga periódicamente una copia de seguridad de la 

base de datos del programa CareLink™ Pro. La base de datos almacena 

todos los datos del programa que se hayan acumulado en los registros 

de pacientes, incluida la información del perfil, los datos procedentes 

de los dispositivos y la configuración de los informes. 

El programa CareLink Pro le permite guardar copias de la base de datos 

y restaurarlas.

También es importante que tenga la versión más reciente del 

programa CareLink Pro. Periódicamente estarán disponibles versiones 

actualizadas que pueden contener importantes mejoras. Puede elegir 

buscar actualizaciones o ser avisado cuando éstas estén disponibles.

Antes de empezar
Se recomienda establecer un plan periódico de copias de seguridad de 

la base de datos. Esto ayudará a asegurarse de que se realicen de forma 

periódica y reducirá al mínimo el riesgo de pérdida de datos. 

Durante la copia de seguridad o la restauración, CareLink Pro detecta 

otros usuarios que puedan estar utilizando el programa en otros ordenadores 

y les ofrece la posibilidad de guardar su trabajo. No obstante, se 

recomienda comprobar si hay otros usuarios utilizando el programa 

antes de comenzar los procesos de copia de seguridad o restauración.
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Actualizaciones del programa

Recepción automática de actualizaciones

En ocasiones habrá actualizaciones del programa CareLink Pro. 

Cuando se muestre un aviso de una actualización, siga los pasos descritos 

a continuación para descargar la versión más reciente del programa.

NOTA: Antes de aplicar
una actualización del

programa debe hacerse
una copia de seguridad

de la base de datos.
Consulte el apartado

Cómo hacer una copia de
seguridad de una base de

datos, en la página 62.

1 Asegúrese de que dispone de una conexión a Internet y de que ésta 

está activa en el ordenador.

2 Se mostrará el mensaje de actualización del programa CareLink Pro 

cuando exista una actualización del programa CareLink Pro. Le ofrece la 

posibilidad de descargar la actualización.

3 Haga clic en DOWNLOAD (Descargar). (Si hace clic en CANCEL 

[Cancelar], se cerrará el aviso de actualización. Puede descargar 

la actualización más adelante).

Aparecerá un mensaje de advertencia que recomienda hacer una 

copia de seguridad de la base de datos.

4 Haga clic en YES (Sí) para crear una copia de seguridad de la base de 

datos (consulte el apartado Cómo hacer una copia de seguridad de 

una base de datos, en la página 62 para informarse sobre este 

procedimiento). Haga clic en NO si decide no hacer una copia de 

seguridad de los datos.

Aparecerá un mensaje que confirma que se ha descargado la nueva 

versión del programa CareLink Pro.

5 Para comenzar a utilizar la versión más reciente del programa 

CareLink Pro, haga clic en YES (Sí) para cerrar y volver a abrir el 

programa. Haga clic en NO si prefiere esperar antes de reiniciar el 

programa CareLink Pro.

Cómo desactivar las actualizaciones automáticas

Si no desea recibir una notificación automática de las actualizaciones 

del programa CareLink Pro, siga los pasos descritos a continuación:

1 Seleccione Tools > Options (Herramientas > Opciones).

2 Haga clic en la ficha General (Generales).

3 En la sección Communications (Comunicaciones), elimine la marca 

de la casilla de verificación situada junto a la opción Automatically

check for software updates (Comprobar automáticamente la 

disponibilidad de actualizaciones del programa).
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Cómo comprobar manualmente la disponibilidad de actualizaciones

Puede comprobar manualmente la disponibilidad de actualizaciones

del programa CareLink Pro en cualquier momento.

NOTA: Antes de aplicar
una actualización del

programa debe hacerse
una copia de seguridad

de la base de datos.
Consulte el apartado

Cómo hacer una copia de
seguridad de una base de

datos, en la página 62.

1 Asegúrese de que dispone de una conexión a Internet y de que ésta 

está activa en el ordenador.

2 Seleccione Tools > Check for Software Updates (Herramientas > 

Comprobar la disponibilidad de actualizaciones del programa).

3 Si no hay actualizaciones disponibles, se mostrará el mensaje 

correspondiente. Si hay una actualización disponible, se mostrará 

un mensaje de actualización del programa CareLink Pro. 

4 Siga el procedimiento descrito en el apartado Recepción automática 

de actualizaciones, en la página 61.

Copia de seguridad y restauración de la base 
de datos

Cómo hacer una copia de seguridad de una base de datos     

Los siguientes pasos le permiten hacer una copia de seguridad de 

la base de datos actual en la ubicación que usted seleccione.

1 Asegúrese de que todos los registros de pacientes están cerrados.

2 Seleccione Tools > Backup Database (Herramientas > Copia de 

seguridad de la base de datos).

NOTA: Las copias de
seguridad de la base de
datos pueden guardarse

en una unidad de red
o en un medio de
almacenamiento

extraíble (DVD, CD,
unidad USB, etc.).

3 Para guardar la copia de seguridad en una ubicación diferente en 

su ordenador, haga clic en la flecha situada a la derecha del campo 

Save in (Guardar en) y seleccione una nueva ubicación.

4 Si desea cambiar el nombre del archivo de copia de seguridad, escríbalo 

en el cuadro File name (Nombre del archivo).

5 Haga clic en SAVE (Guardar). Mientras se guarda la base de datos 

aparece una barra de progreso.

Cuando la copia de seguridad finalice, aparecerá un mensaje.

6 Haga clic en OK (Aceptar) para cerrar el mensaje.
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Cómo restaurar una base de datos            

Puede ser necesario sustituir la base de datos actual en caso de que 

no sea posible acceder a ella o utilizarla.

PRECAUCIÓN: Cuando se restaura con una copia de seguridad, se pierden todos los datos 
nuevos creados desde que se realizara la copia de seguridad seleccionada.

Los siguientes pasos le permiten seleccionar una copia de seguridad 

para sustituir la base de datos actual.

1 Asegúrese de que todos los registros de pacientes están cerrados.

2 Seleccione Tools > Restore Database (Herramientas > Restaurar la 

base de datos). 

3 Seleccione el archivo de copia de seguridad que desee utilizar para 

sustituir la base de datos actual (generalmente el más reciente).

4 Haga clic en OPEN (Abrir). Aparece un mensaje de advertencia. Haga 

clic en OK (Aceptar).

5 Mientras se restaura la base de datos aparece una barra de progreso.

Cuando la restauración de la base de datos haya finalizado, 

aparecerá un mensaje.

6 Haga clic en OK (Aceptar) para cerrar el mensaje.

Cuando el programa no está disponible                

Si intenta iniciar el programa mientras otro usuario está realizando 

una copia de seguridad o una restauración, recibirá un mensaje 

avisándole de que el programa no está disponible. No podrá acceder 

al programa hasta que haya finalizado la operación.

Realice una de las acciones siguientes:

• Espere a que finalice el proceso y a que el programa esté disponible.

• Haga clic en CANCEL (Cancelar) e inténtelo de nuevo más tarde.
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Resolución de problemas 9

Contenido de este capítulo
• Errores generales de uso del programa: página 64

• Errores de lectura de dispositivos: página 65

• Errores en la creación de informes: página 68

• Errores en tareas de copia de seguridad y restauración: página 68

• Desinstalación del programa: página 69

Este capítulo tiene por finalidad ayudarle a resolver los problemas 

que puedan surgir durante el uso del programa CareLink™ Pro. También 

contiene instrucciones para desinstalar el programa CareLink Pro en 

caso de que fuera necesario.

Errores generales de uso del programa

Privilegios para descargar actualizaciones del programa a través 
de Internet

Si intenta descargar una actualización del programa a través de 

Internet, es posible que aparezca un mensaje que le indique que 

no tiene suficientes privilegios para ello. Debe tener privilegios 

administrativos para descargar actualizaciones del programa CareLink Pro.

1 Cierre el programa CareLink Pro y reinicie el ordenador. 

2 Pida a alguien que tenga privilegios administrativos que inicie una 

sesión en el ordenador.

3 Siga las instrucciones descritas en el apartado Actualizaciones del 

programa, en la página 61.
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No hay conexión con la base de datos

Un mensaje de error que indica que no está conectado a la base de 

datos indica una de las posibilidades siguientes:

• Se ha movido la base de datos. La base de datos debe estar ubicada 

en el mismo lugar seleccionado durante la instalación del programa 

CareLink Pro. Si se ha movido, deberá devolverse a la ubicación 

seleccionada durante la instalación.

• No está conectado a la unidad de red en la que se encuentra la base 

de datos. Si la base de datos está ubicada en una unidad de red, 

en ocasiones la red podría experimentar problemas que le impidan 

acceder a la unidad. Póngase en contacto con el departamento 

informático para solicitar ayuda para volver a conectarse a la unidad 

de red en la que se encuentra la base de datos. 

Ha olvidado la contraseña del centro para el programa CareLink Pro

Si nadie recuerda la contraseña que utiliza el centro médico para 

iniciar una sesión en el programa CareLink Pro, se deberá reinstalar el 

programa CareLink Pro y crear una nueva base de datos. Una vez haya 

reinstalado el programa, no podrá acceder a ninguna información de 

los pacientes que estuviera almacenada en la base de datos anterior. 

Guarde la contraseña que cree durante la nueva instalación en algún 

lugar de la consulta, de forma que no pierda los datos futuros. 

Errores de lectura de dispositivos

Error de lectura del 
dispositivo

Explicación

The selected serial port 
could not be opened. 
Another operation might 
be in progress on that port. 
Please wait until the port is 
available, or select another 
port. (No ha sido posible 
abrir el puerto en serie 
seleccionado. Es posible que 
haya otra operación en curso 
en ese puerto. Espere a que 
el puerto esté disponible 
o seleccione otro puerto).

Compruebe que el puerto COM seleccionado 
no esté siendo utilizado por otro programa 
o seleccione un puerto diferente. Pruebe a reiniciar 
el ordenador que está utilizando e intente leer 
el dispositivo de nuevo. Es posible que el hardware 
(cable, etc.) conectado al puerto o el propio 
puerto estén dañados. Conecte el hardware a otro 
puerto e intente leer el dispositivo de nuevo para 
identificar el problema. 



Guía del usuario del programa CareLink Pro™    Resolución de problemas      66

Auto Detect could not find 
the device on any available 
port. Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port. 
(La función de detección 
automática no ha encontrado 
el dispositivo en ningún 
puerto disponible. Compruebe 
la conexión del cable y la 
batería y el estado del 
dispositivo e inténtelo de 
nuevo, o pruebe a especificar 
un puerto en serie).

Compruebe la conexión entre el cable y el PC 
y asegúrese de que el estado de la batería 
del dispositivo sea correcto. Si es así, pruebe 
a especificar el puerto en serie del PC al que está 
conectado el cable en lugar de seleccionar la 
opción Auto Detect (Detección automática).

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try again, 
try selecting a different port, 
or try to Auto Detect the 
device. (No se ha encontrado 
el dispositivo en el puerto 
en serie seleccionado. 
Compruebe la conexión del 
cable y la batería y el estado 
del dispositivo e inténtelo 
de nuevo, o pruebe 
a seleccionar un puerto 
diferente o utilice la opción 
Auto Detect [Detección 
automática]).

Compruebe la conexión entre el cable y el PC 
y asegúrese de que el estado de la batería 
del dispositivo sea correcto. Si es así, pruebe 
a seleccionar un número de puerto en serie 
del PC diferente o elija la opción Auto Detect 
(Detección automática).

Unable to communicate with 
the device. Please ensure 
you’ve attached and 
selected the correct device, 
check the cable connection, 
device battery and status, 
and try again. (No es posible 
establecer la comunicación 
con el dispositivo. Asegúrese 
de que ha conectado 
y seleccionado el dispositivo 
correcto, compruebe la 
conexión del cable y la 
batería y el estado del 
dispositivo e inténtelo 
de nuevo).

Compruebe todos los valores seleccionados 
para el dispositivo leído, incluidos el nombre 
del dispositivo, el número de serie y el tipo 
de conexión. Asegúrese también de que el 
dispositivo, el cable y el PC están correctamente 
conectados. Compruebe que el estado de la 
batería y de la alarma del dispositivo es correcto. 
Intente leer el dispositivo de nuevo.

Unexpected response… 
retrying (n%) (Respuesta 
inesperada… intentándolo 
de nuevo [n%])

Se ha leído un valor inesperado del dispositivo. 
El programa reintentará la comunicación hasta 
que usted cancele la operación o se establezca 
la comunicación.

Error de lectura del 
dispositivo

Explicación
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The communication device 
was found, but the pump 
(<serial #>) is not responding. 
Please verify the pump’s 
serial number, place 
the pump closer to the 
communication device to 
minimize interference, 
check pump battery and 
status. (Se ha encontrado el 
dispositivo de comunicación, 
pero la bomba [n.º de serie] 
no responde. Compruebe el 
número de serie de la bomba, 
aproxime la bomba al dispositivo 
de comunicación para reducir 
al mínimo la interferencia 
y compruebe la pila y el 
estado de la bomba).

Compruebe que se ha introducido el número de 
serie correcto de la bomba. Si no es así, vuelva 
a introducir el número de serie correcto. Si el 
número de serie es correcto, pruebe a aproximar 
la bomba al dispositivo de comunicación o alejar 
el dispositivo de comunicación y la bomba de 
posibles fuentes de interferencia (como otros 
dispositivos de radiofrecuencia), o compruebe 
el estado de administración y la pila de la bomba.

This pump is delivering 
a temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again. (Esta bomba está 
administrando un basal 
temporal. Cancele el basal 
temporal o espere a que éste 
finalice y, a continuación, 
inténtelo de nuevo).

La bomba que está intentando leer está 
administrando un basal temporal. Espere a que 
finalice el basal temporal para leer la bomba 
o cancele el basal temporal y, a continuación, 
lea la bomba.

This pump has active errors 
or alarms. Please clear 
the alarms and try again. 
(Esta bomba tiene alarmas 
o errores activos. Resuelva 
las alarmas e inténtelo de 
nuevo).

Hay alarmas activas en la bomba que impiden su 
lectura. Lea las instrucciones de la alarma para 
resolverla. Resuelva la alarma e intente leer la 
bomba de nuevo.

This pump is delivering 
a bolus. Please cancel the 
bolus or wait until it completes, 
and then try again. (Esta bomba 
está administrando un bolus. 
Cancele el bolus o espere a que 
éste finalice y, a continuación, 
inténtelo de nuevo).

La bomba que está intentando leer está administrando 
un bolus. Espere a que finalice el bolus para leer 
la bomba o cancele el bolus y, a continuación, lea 
la bomba.

The device returned invalid 
entries; all data read will 
be discarded. (El dispositivo 
ha devuelto entradas no 
válidas; se desecharán todos 
los datos leídos).

Póngase en contacto con su representante local 
(consulte el apartado Asistencia técnica, en la 
página 3).

Error de lectura del 
dispositivo

Explicación
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Errores en la creación de informes

Múltiples entradas de datos para la misma fecha

Si existen varias entradas de datos para la misma fecha y hora para el 

mismo dispositivo, el programa considera que se trata de un conflicto 

que no puede resolver. Los informes creados utilizando los datos de 

este dispositivo omitirán la parte coincidente de los datos. 

Puede intentar ajustar el período del informe para omitir los datos 

coincidentes. O puede borrar el dispositivo del programa y añadirlo 

de nuevo para borrar las lecturas previas.

El programa va a ignorar datos

Si se ha modificado la hora de un dispositivo y esto ha causado coincidencias 

o vacíos en los datos de tres horas o más, el programa no incluirá esa 

parte de los datos al crear informes.

Errores en tareas de copia de seguridad 
y restauración

No puede bloquearse la base de datos

Esto significa que está utilizando el programa en un entorno multiusuario 

y que otros usuarios están conectados. El programa no permitirá realizar 

una copia de seguridad de la base de datos mientras otros usuarios 

puedan estar realizando tareas que podrían afectar a la base de datos. 

Una vez que todos los demás usuarios hayan salido de CareLink Pro, 

podrá realizar la copia de seguridad de la base de datos.

No puede finalizar una copia de seguridad o una restauración 
de la base de datos

Otros usuarios no pueden conectarse y la copia de seguridad 

o restauración no puede finalizar. Póngase en contacto con la línea 

de asistencia o con su representante local (consulte el apartado 

Asistencia técnica, en la página 3).

Fallo en la restauración de la base de datos

El archivo de copia de seguridad de la base de datos que está intentando 

utilizar para el proceso de restauración está dañado. Intente realizar 

la restauración con un archivo de copia de seguridad diferente.
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Desinstalación del programa

Si necesita desinstalar el programa CareLink Pro, siga los pasos 

indicados a continuación:

1 Abra el Panel de control a través del menú Inicio de Windows.

2 Seleccione Agregar o quitar programas. Se mostrará la ventana 

Agregar o quitar programas.

3 Desplácese hasta Medtronic Carelink Pro y haga clic en él.

4 Haga clic en Quitar. Aparecerá el asistente InstallShield Wizard.

5 Haga clic en Siguiente. Aparecerá un mensaje pidiéndole que confirme 

que desea borrar la aplicación.

6 Haga clic en Sí. Se ejecutará el programa de desinstalación que 

borrará del ordenador el programa y todos sus archivos. Cuando haya 

finalizado, aparecerá un mensaje en la pantalla del asistente para 

confirmar la desinstalación.

7 Haga clic en Finalizar.
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Tabla de iconos
En la siguiente tabla se presentan los iconos y símbolos que aparecen 

en las etiquetas del envase y en el equipo:

Descripción Icono

Uno por envase/paquete (1x) 

Atención: Consulte las instrucciones de uso

CD adjunto

Documentos importantes adjuntos

Número de catálogo REF

Marcado CE por organismo notificado como 
producto sanitario
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Datos de los archivos CSV A

Este anexo describe los datos del programa CareLink™ Pro que se ven 

al exportar los datos en el formato CSV. 

Definiciones de los datos de las columnas

Encabezado de la columna Definición

Index (índice) Orden en que se registraron los datos 
en el dispositivo.

Date (fecha) Fecha en que se registraron los datos 
en el dispositivo.

Time (hora) Hora en que se registraron los datos 
en el dispositivo.

New Device Time 
(nueva hora del dispositivo)

Nueva fecha y hora si se ha cambiado 
en el dispositivo.

BG Reading 
(mg/dL or mmol/L) 
(valor de GS 
[mg/dL o mmol/L])

Valor de glucosa en sangre registrado por el 
medidor, Guardian o la bomba. Si los datos 
proceden de una bomba o Guardian, esta columna 
refleja los valores de GS por punción digital y los 
valores de GS recibidos del medidor Link. 

Linked BG Meter ID 
(ID del medidor 
de glucemia vinculado)

Número de serie del medidor que envió una 
determinada lectura de glucosa en sangre al 
dispositivo.

Basal Rate (U/h) 
(índice basal [U/h])

Índice basal activo de administración de insulina 
en unidades por hora.

Temp Basal Amount 
(cantidad de basal temporal) 

Si se aplicó un basal temporal en la bomba, 
este valor es el Temp Basal amount 
(Cantidad de basal temporal). 

Temp Basal Type 
(tipo de basal temporal)

El tipo de ajuste de los basales temporales 
(índice de insulina o porcentaje del basal).

Temp Basal Duration (m) 
(duración del basal temporal 
[min])

Duración, en minutos, de la administración de un 
basal temporal de insulina (consulte el tipo más 
arriba).
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Bolus Type (tipo de bolus)
Tipo de bolus de insulina administrado (normal, 
cuadrado, dual [parte normal] o dual [parte 
cuadrada]).

Bolus Volume Selected (U) 
(volumen del bolus 
seleccionado [U])

Número de unidades de insulina seleccionado 
para administrarse durante el bolus de insulina.

Bolus Volume Delivered (U) 
(volumen del bolus 
administrado [U])

Número de unidades de insulina administradas 
realmente durante el bolus de insulina.

Programmed Bolus Duration (h) 
(Duración del bolus 
programado [h])

Duración de un bolus cuadrado o de la parte 
cuadrada de un bolus dual.

Prime Type (tipo de cebado)

Manual o fijo. El cebado manual se utiliza justo 
después de un rebobinado para llenar de insulina 
el tubo del equipo de infusión antes de insertarlo. 
El cebado fijo se utiliza después de la inserción 
del equipo de infusión para llenar la cánula 
blanda con insulina después de retirar la aguja 
introductora.

Prime Volume Delivered (U) 
(volumen de cebado 
administrado [U])

Número de unidades de insulina administradas 
realmente para el cebado.

Alarm (alarma) Nombre de la alarma generada.

Suspend (suspender) Identifica el estado suspendido de la bomba.

Rewind (rebobinar) La fecha y la hora en que el dispositivo fue 
rebobinado.

BWZ Estimate (U) 
(estimación con 
Bolus Wizard [U])

Estimación del bolus de insulina calculado con 
la función Bolus Wizard en la bomba Paradigm.

BWZ Target High BG 
(mg/dL or mmol/L) 
(límite superior del objetivo 
de GS con Bolus Wizard 
[mg/dL o mmol/L])

Valor para el límite superior del intervalo del 
objetivo de glucosa en sangre utilizado por 
la función Bolus Wizard.

BWZ Target Low BG (mg/dL 
or mmol/L) (límite inferior 
del objetivo de GS con Bolus 
Wizard [mg/dL o mmol/L])

Valor para el límite inferior del intervalo del 
objetivo de glucosa en sangre utilizado por 
la función Bolus Wizard.

BWZ Carb Ratio 
(ratio de carbohidratos 
con Bolus Wizard)

Valor para la relación insulina/carbohidratos. 
Si se utilizan los gramos como unidad, el ratio 
es el número de gramos cubiertos por una unidad 
de insulina. Si se utilizan las raciones para las 
unidades, el ratio es el número de unidades de 
insulina utilizadas para cubrir una ración.

BWZ Insulin Sensitivity 
(sensibilidad a la insulina 
con Bolus Wizard)

El valor para la sensibilidad a la insulina. La 
sensibilidad a la insulina es la cantidad en que 
disminuye el nivel de glucosa en sangre por 
unidad de insulina. Es utilizado por la función 
Bolus Wizard.

BWZ Carb Input 
(entrada de carbohidratos 
en Bolus Wizard)

Cantidad de carbohidratos introducida en el Bolus 
Wizard y utilizada para estimar un bolus.

Encabezado de la columna Definición
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Más información sobre los archivos CSV exportados 
por CareLink Pro

El título mostrado en la parte superior del archivo CSV incluye la 

siguiente información:

• nombre del paciente

• lista de dispositivos seleccionados y sus números de serie

• intervalo de fechas seleccionado

Cada bloque de columnas tiene un título que incluye la siguiente 

información:

• nombre del dispositivo al que corresponde el bloque de datos

• número de serie de ese dispositivo 

BWZ BG Input 
(mg/dL or mmol/L) 
(entrada de GS en Bolus 
Wizard [mg/dL o mmol/L])

Lectura de la glucosa en sangre introducida en 
el Bolus Wizard y utilizada para estimar un bolus.

BWZ Correction Estimate (U) 
(estimación para corrección 
con Bolus Wizard [U])

Unidades del bolus de insulina que hay que 
administrar para corregir el nivel de glucosa en 
sangre, calculadas por medio del Bolus Wizard.

BWZ Food Estimate (U) 
(estimación para la comida 
con Bolus Wizard [U])

Unidades del bolus de insulina que hay que 
administrar para cubrir la cantidad prevista de 
ingesta de carbohidratos, calculadas por medio 
del Bolus Wizard.

BWZ Active Insulin (U) 
(insulina activa con 
Bolus Wizard [U])

Cantidad de insulina activa que se calcula que 
quedará en el cuerpo de administraciones previas 
de bolus de insulina al determinar la cantidad de 
bolus estimada con la función Bolus Wizard.

Sensor Calibration BG 
(mg/dL or mmol/L) 
(GS para calibración del 
sensor [mg/dL o mmol/L])

Valor de GS utilizado para calibrar el sensor, 
en mg/dL o mmol/L.

Sensor Glucose 
(mg/dL or mmol/L) 
(glucosa del sensor 
[mg/dL o mmol/L])

Valor de glucosa del sensor.

ISIG value (valor ISIG) Señales de entrada (ISIG), leídas por el sensor, 
medidas en nanoamperios (nA).

Encabezado de la columna Definición
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Si los datos no aparecen tal como se prevé

Existen diferentes factores que pueden provocar que los datos 

del archivo CSV se presenten de manera distinta a la esperada.

• Los cambios en la fecha o la hora del dispositivo pueden modificar la 

secuencia o hacer que los registros queden fuera del intervalo de 

fechas seleccionado para mostrar.

• Si existe un vacío grande entre las lecturas del dispositivo, es posible 

que los datos de dicho dispositivo se presenten en varios bloques.
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Glosario

A
A1c  Hemoglobina glucosilada.  

Advertencia de reservorio bajo  Aviso programable que le informa 
con una alerta cuando queda un número especificado de unidades en 
el reservorio o cuando resta una cantidad de tiempo específica para 
que el reservorio quede vacío.

Área media bajo la curva (AUC)  Es el valor medio de exposición 
a hiperglucemia o hipoglucemia durante el tiempo en que el sensor 
ha estado transmitiendo.

Aviso de calibración  El valor del Cal Reminder (Aviso de calibración) 
es el periodo de antelación, previo al momento en que el valor 
de calibración actual caduca, con que el usuario desea que se le 
recuerde la calibración mediante la emisión de una alarma METER BG 
BY (Medir GS) por parte de la bomba. Por ejemplo, si la función 
Cal Reminder (Aviso de calibración) se fija en dos horas, la alerta 
METER BG BY (Medir GS) se activará dos horas antes de que se necesite 
la calibración.

B
Basal temporal (basal temp)  Insulina basal temporal única con 
una cantidad y una duración específicas. Se utiliza para apoyar las 
necesidades de insulina durante actividades o situaciones especiales 
que no forman parte de la rutina diaria normal.

Bolus corrector Cantidad de insulina necesaria para devolver un 
nivel alto de glucosa en sangre a un valor dentro del intervalo del 
objetivo de glucosa en sangre.

Bolus de comida  Dosis de insulina administrada para cubrir la 
elevación esperada de la glucosa en sangre que se produce después 
de una comida.

Bolus de insulina  Dosis de insulina administrada para cubrir una 
elevación esperada de la glucosa en sangre (como la elevación que 
tiene lugar después de una comida o un tentempié) o para reducir 
un nivel alto de glucosa en sangre hasta el intervalo del objetivo de 
glucosa en sangre.
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Bolus Dual Wave® (bolus dual)  Combinación de un bolus normal 
que se administra inmediatamente, seguido de un bolus de onda 
cuadrada. La parte de onda cuadrada se administra de manera 
uniforme durante cierto período de tiempo.

Bolus Express  Método de administración de cualquier tipo de bolus 
mediante el botón Bolus Express de la bomba.

Bolus manual  Elemento opcional disponible en el BOLUS MENU 
(Menú Bolus) cuando la función Bolus Wizard está activado. Método 
de programación de un bolus sin la función Bolus Wizard. 

Bolus máximo  Cantidad máxima de bolus de insulina que la bomba 
administrará de una sola vez. (Definido por el usuario).

Bolus normal  Administración inmediata de una cantidad de unidades 
de insulina específica. 

Bolus Square Wave® (bolus cuadrado)  Bolus administrado de 
manera uniforme durante un período de tiempo especificado por 
el usuario (entre 30 minutos y 8 horas). 

C
CareLink™ Personal  Servicio en línea que permite administrar 
los datos de diabetes a través de Internet.

CH Carbohidratos.

Com-Station Dispositivo que se utiliza para descargar los datos de la bomba 
MiniMed 508 y de medidores de otros fabricantes en el ordenador.

ComLink  Dispositivo de transferencia de radiofrecuencia (RF) 
utilizado para cargar datos de la bomba Paradigm o el sistema de 
monitorización continua de glucosa Guardian REAL-Time en el PC.

Concentración de insulina  Concentración o tipo de insulina que el 
médico ha recetado al usuario. Afecta a la velocidad con la que la 
bomba administra la insulina. Si cambia la concentración de insulina 
del usuario, deben volver a programarse los patrones basales y los 
índices basal máximo y de bolus.

E
Easy Bolus™  Método de infusión para un bolus normal utilizando el 
botón Easy Bolus de la bomba.

Equipo de infusión  Aparato utilizado para insertar y fijar una cánula 
bajo la piel y transportar la insulina hasta el punto de inserción a través 
de un tubo desde la bomba.

F
Factor del bolus corrector (factor de sensibilidad)  Cuánto rebajarán 
1,0 unidades de insulina el nivel de glucosa en sangre. Este factor se 
utiliza para calcular la cantidad del bolus corrector cuando la glucosa 
en sangre está alta.
(nivel de GS) – (objetivo de GS) = X. 
X ÷ (factor del bolus corrector) =  
cantidad del bolus corrector
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G
Glucosa alta La bomba generará una alarma si el sensor indica que 
el valor de glucosa del sensor es igual o superior a este valor. Tiene 
la opción de activar o desactivar esta función.

Glucosa baja  La bomba generará una alarma si el sensor indica que 
el valor de glucosa del sensor es igual o inferior a este valor. Tiene 
la opción de activar o desactivar esta función.

GS Glucosa en sangre.

H
HbA1c  Hemoglobina glucosilada.

Hiperglucemia  Elevación de la glucosa en sangre detectada al 
controlar los niveles de glucosa en sangre, con o sin alguno de los 
siguientes síntomas o todos ellos: náuseas, vómitos, visión borrosa, 
cefalea, molestias gástricas, micción frecuente de grandes cantidades 
de orina y letargo. 

Hipoglucemia  Disminución de la glucosa en sangre detectada 
al controlar los niveles de glucosa en sangre, con o sin alguno de 
los siguientes síntomas o todos ellos: hambre excesiva, agitación 
o temblores, sudoración, visión borrosa, mareo, cefalea, lenguaje 
farfullante, cambios súbitos del estado de ánimo o cambios de la 
personalidad.

I
ID transm   Número de serie del transmisor que se está utilizando 
actualmente.

Índice basal  Ajuste de la bomba que proporciona una infusión 
continua de insulina para mantener el nivel de glucosa en sangre 
estable entre las comidas y durante la noche. La insulina basal 
reproduce la liberación de insulina pancreática, que cubre todas 
las necesidades de insulina no relacionadas con las comidas.

Insulina basal  Infusión continua por horas de insulina administrada 
automáticamente por una bomba de insulina según perfiles preprogramados 
e índices personalizados definidos en la bomba. La bomba administra una 
infusión diaria de insulina que generalmente cubre las necesidades "basales" 
de insulina durante los períodos de ayuno (por la noche y entre comidas).

Insulina basal máxima  Cantidad máxima de insulina basal que 
la bomba administrará de una sola vez. (Definido por el usuario).
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M
Medidor Dispositivo médico para determinar la concentración 
aproximada de glucosa en la sangre. Se coloca una pequeña gota de 
sangre en una tira de análisis desechable, que el medidor lee y utiliza 
para calcular el nivel de glucosa en sangre. A continuación, el medidor 
muestra el nivel en mg/dl o mmol/l. 

μL Microlitro.

O
Opción del medidor  Función que permite que la bomba reciba 
lecturas de glucosa procedentes de un medidor de glucemia vinculado.

P
Parte cuadrada  (Cuad) La segunda parte de un bolus dual. La parte 
cuadrada se administra de manera uniforme durante un período de 
tiempo después de la parte AHORA.

Paso  Incremento de insulina que puede ajustar y utilizar para la 
administración de un Easy Bolus.

Patrón A/B  Patrón basal que cubre niveles de actividad que no 
forman parte de sus actividades cotidianas, pero que son normales 
dentro de su estilo de vida. Estas situaciones podrían ser la práctica 
de un deporte que realice una vez por semana o un cambio en su 
hábitos de sueño durante el fin de semana, períodos prolongados de 
mayor o menor actividad o la menstruación.

Patrón estándar  El patrón basal normal que soporta su actividad 
diaria normal. Cuando la función Patrones está desactivada, la bomba 
utiliza su patrón estándar (basal).

Patrones basales  El usuario puede programar un máximo de tres 
patrones de índice basal diferentes en la bomba para la administración 
de insulina basal: Estándar, Patrón A y Patrón B. Para cada patrón 
existe la opción de configurar un máximo de 48 índices basales.

Perfil basal  Índice basal con una hora inicial y final. El usuario puede 
programar varios perfiles diferentes en la bomba, cada uno con un 
índice basal diferente, durante un período de 24 horas para conseguir 
un mejor control de la glucosa.

Prueba de A1c Prueba de hemoglobina A1c que se utiliza para 
interpretar el nivel de glucosa en sangre durante un período de tiempo.

Prueba de cuerpos cetónicos  Los cuerpos cetónicos son productos 
de desecho que se generan cuando el organismo se ve obligado 
a quemar grasas corporales en lugar de glucosa para obtener energía. 
Puede ser un signo de falta de insulina en el organismo. La prueba de 
cuerpos cetónicos mide la cantidad de cuerpos cetónicos concentrados 
en la sangre o la orina.

Prueba de HbA1c  Prueba de hemoglobina A1c que se utiliza para 
interpretar el control de la glucosa en sangre o la media de los 
niveles durante un período de tiempo de 2 a 3 meses.
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R
Ratio de CH (ratio de carbohidratos)  La cantidad de carbohidratos 
cubiertos por una unidad de insulina. (Véase también Ratio de raciones).

Ratio de raciones  Cantidad de insulina necesaria para cubrir una (1) 
ración de carbohidratos. (Véase también Ratio de CH).

RF  Radiofrecuencia (RF). 

S
Sensibilidad a la insulina  Cantidad de mg/dL (o mmol/L) en que 
se reduce el nivel de glucosa en sangre (GS) por unidad de insulina. 
(Datos de la función Bolus Wizard).

Sonido de bolus  La bomba puede programarse para que el usuario 
oiga un pitido cuando seleccione una cantidad de bolus de insulina 
(por ejemplo, 0,5 ó 1,0 unidades) a administrar. Es útil para 
situaciones en las que resulte difícil ver los botones de la bomba.

Suspender  Función de la bomba que detiene todas las administraciones 
de insulina. Se cancela toda administración de bolus y/o cebado en 
curso. La administración basal queda en pausa hasta su reanudación. 

T
Temp  Temporal.

Transferencia  Proceso de envío de datos de la bomba o medidor 
al programa CareLink™ Personal.

U
Unidades de carbohidratos  La entrada de una comida cuando 
se utiliza la función Bolus Wizard. Se introduce en gramos 
(de carbohidratos) o raciones.

USB CareLink™ Dispositivo utilizado para cargar datos almacenados 
en una bomba de insulina de la serie Medtronic Diabetes Paradigm, 
o en un monitor Guardian REAL-Time, en el programa CareLink™

utilizando un puerto USB de su ordenador.

V
Vincular  Activar y configurar la opción del medidor que permite que 
la bomba reciba las lecturas de GS de los medidores CONTOUR® LINK, 
OneTouch® UltraLink™ o Paradigm Link®.

También se utiliza en este programa para hacer referencia a los 
vínculos de hipertexto. Cuando se hace clic en ellos, los vínculos 
de hipertexto llevan a otro lugar del programa o a otro sitio web.
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